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Digital Rapids Stream Software
Getting Started with Stream Software
There are 5 basic steps to using your Stream system to create a digital video 
output. 

1.  Create Codec Profiles (the encoder settings) or add previously created 
Codec Profiles

2.  Select your input video or input files (or deck control with Stream FE)

3.  Optional step: Adjust your input video processor and/or audio processor 
and level controls; you can also add software Plugins

4.  Select your outputs for each Codec Profile

5.  Click Start to begin encoding, and Stop to end encoding
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Digital Rapids Stream Software
Codec Profiles
A codec profile is a file which contains all of the settings that are needed to 
control the encoding of one output type. For example, to create 3 output files 
for 3 different target audiences, a Windows Media file at 320x240 and 
300kbps, and a H.264 file at 160x120 at 50kbps, and a QuickTime file at 
320x240 at 400kbps, you would need to create 3 codec profiles, one for each 
of your specific target audiences.

Creating a Codec Profile
To create a Codec Profile use the main menu and select Codec Profile, then 
choose the type of codec you would like to use. Note that a Group codec is a 
special type of codec used to combine other codecs, and it is covered in its own 
section, “Group Codec Profile” on page 15.

When you select a regular codec (any codec except the Group codec), the 
settings window for that particular codec will open. Each codec has different 
available settings.  However, certain settings will be common to most codecs.  
These may include:

Resolution (width by height in pixels)

Frame rate (frames per second or fps)

Video Data rate (in kbps or Mbps) 

Audio data rate (in kbps) – for some codecs the video and audio data rates are 
combined into one setting

De-interlace – If you want to de-interlace a live video input you will get better 
results if you use the Stream hardware’s de-interlace function (rather than the 
codec’s software de-interlace function), so normally you will disable the 
codec’s de-interlace function. If you are using a video file as an input you will 
not be able to use the Stream hardware’s de-interlace function. The Stream 
deinterlace plugin is recommended when transcoding files.

Bit rate/type of encode: CBR (constant bit rate), VBR (variable bit rate) or 2-
pass encode (note that a 2-pass encode cannot be real-time)

Most codec settings windows will also have an Advanced button.  This gives 
you access to the controls which are specific to the codec you have selected.

Once your codec settings are complete, click the Save + Add button to save 
the codec profile, and to add it to the Codec Profile list that will be used for this 
project. You may click the Save button to save the profile without adding it to 
the current project’s codec list, or cancel to close the window without saving. 

Once your codec profiles have been added to the list, you can select a specific 
codec profile and some details about that profile will appear on the Profile Tab.
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Codec Profiles with Multichannel Audio
Currently you can make a multichannel audio codec profile for WAV, AVI and 
WM9/VC-1. If you have the Dolby Digital Surround option you will also be able 
to create a stereo or 5.1 channel AC-3 or EC-3 file. If you have the Thomson 
MP3 option you will be able to make a stereo or 5.1 surround mp3 file.

AVI:  Following the Audio Compressor drop down box you will see a setting 
button. Click this button and you will see a Number of Channels drop down box.

Dolby Digital: Choose a Stereo or Surround codec profile.

Dolby Pulse: Choose a Stereo or Surround codec profile.

Thomson MP3: Choose the number of channels: mono, stereo or 5.1.

WAV:  You will see all of the Multichannel audio modes in the Number of 
Channels drop down box, including a Custom setting so that you can configure 
your own.

WM9/VC-1:  Choose “Windows Media Audio 10 Professional” or “Windows 
Media Audio 9.2” as your Audio Media Type.  When you add a new  target bit 
rate (or edit an existing one) you will see 2 channel, 5.1 channel and 7.1 
channel options in the Audio Format drop down box. 

Creating Full-Sized SD Codec Profiles
The DRC-500 to DRC-2600 boards use an NTSC input resolution of 720 x 480. 
PAL input resolution is 720 x 576. You can add VBI lines when using the DRC-
1000 to 2600 boards.

Note that the high definition DRC-5550 to 5650 boards can be set to use an 
NTSC video input resolution of 720 x 486 or 720 x 480. 

When using the high definition DRC-5500 series boards you can also choose 
an input resolution of 720 x 512 (for NTSC) or 720 x 608. This allows you to 
capture VBI lines.

Creating HD Sized Codec Profiles
If you have one of the high definition DRC-5550 or DRC-5650/5600 boards, 
you will be able to encode to an HD file in real time.

Using a system with dual single-core 3.6 GHz processors (or higher speeds or 
more CPU cores) you will be able to capture in real time to an uncompressed 
AVI file. You will also be able to capture 1280x720 24P in real time to a WM9 
file or to an MPEG2 file (with some restrictions on maximum data rate and 
other settings). You will not be able to use Stream to capture files at higher 
resolutions or frame rates in real time to a WM9 file or MPEG2 file without a 
faster system.
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Digital Rapids Stream Software
Using a system with dual dual-core 3.0 GHz processors, you will be able to 
capture MPEG2 file up to full 1920x1080 at 30 fps in real time (with some 
restrictions on maximum data rate and other settings). A dual quad-core will 
give you even more real-time MPEG2 options. 

If you want to capture to an uncompressed AVI file and then automatically 
transcode to the other formats, you can use the “Batch Mode” (instead of the 
default Concurrent Mode) to automate the process.  (These modes can be set 
using the drop down box found in the lower left hand corner of the Stream 
interface and are explained in a later section.)

Adding a Codec Profile
Once a codec has been saved, it can be added to the project’s clicking on the 
blue + button at the bottom of the Codec Profile list.  

Modifying a Codec Profile
If you want to remove a codec profile from the list, highlight the codec and then 
click on the red X button.  If you want to modify the codec profile, right click on 
a profile in the list and select Adjust Profile Settings. This will re-open the 
codec’s settings window. After you have made your changes, click Save.  You 
will be asked “Do you want to save the new settings to the original profile?”  If 
you click yes, the original profile will be overwritten.  If you click no, and you 
renamed the profile on the settings window before clicking Save, your settings 
will be saved to a new file with the new file name.  If you did not rename the 
profile before clicking Save, your modified settings will be used for this project, 
but the modified profile will not be saved.

Fix Aspect Ratio
You can right click on a codec profile in your list and select Fix Aspect Ratio.  
This option allows you to override the resolution that has been defined in the 
codec profile based on the aspect ratio defined in the Input. (Most of the 
codecs and players available today do not support automatic aspect ratio 
correction on playback. MPEG2 is a notable exception as it does handle 
aspect ratio correctly, but it does not allow for arbitrary aspect ratios.)

For example, if your input has an  aspect ratio of 16:9, and your codec profile 
resolution was 320x240 (a 4:3 aspect ratio), the “fixed” resolution would be 
320x180. Without this “fix” the video would look “squished” because the input 
and output aspect ratios do not match.
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Fix Aspect Ratio >Adjust Height  
This will change the height while keeping the width the same. 

Fix Aspect Ratio > Adjust Width 
This will change the width while keeping the height the same.

Fix Aspect Ratio > Auto Height Adjustment 
Automatically adjusts the height based on the aspect ratio defined in the Input 
Profile. Changing source profiles will automatically cause new values to be 
calculated and applied.

Fix Aspect Ratio > Auto Width Adjustment  
Automatically adjusts the width based on the aspect ratio defined in the Input 
Profile. Changing source profiles will automatically cause new values to be 
calculated and applied.

Fix Aspect Ratio > Auto Adjustment Disabled  
Disables auto adjustment features. This is the default mode.

Fix Aspect Ratio > Group  
Note that if you right click on the Codec Profile heading instead of an individual 
codec profile in the list you will be able to adjust all of the codec profiles in the 
same way.  The default is “Individual Adjustment”.

Concurrent, Queued and Batch Modes
You can encode to more than one codec profile simultaneously in real-time. 
Exactly how many depends on the codec format, resolution and bit rate, as well 
as your system’s available CPU power and memory. For a rough guide, refer 
to the Appendix for a chart that shows some benchmark testing that was done 
using a StreamZ server.

To encode to all of the formats in your Codec Profile list simultaneously, select 
Concurrent Mode from the drop-down box at the bottom of the Codec Profile 
list. Concurrent Mode is the default mode.

If you want to encode to a codec profile (or profiles) that cannot be encoded in 
real-time, for example a 2 pass encode, or if you want to encode to multiple 
formats and do not have enough system resources to encode all of them in 
real-time, then you will need to switch from Concurrent Mode to Queued Mode 
or Batch Mode.

Queued Mode can be used to transcode to the profiles in the Codec Profile 
list, one at a time, from a master file. Queued Mode cannot be used for live 
input (real-time) encodes. To use Queued Mode, create a master file first using 
Concurrent Mode.  The master file is typically an uncompressed or lossless 
AVI file.  Then switch to Queued Mode, select the master file as the input, and 
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add the codec profiles you want to use into the Codec Profile list. Click the Start 
button and the master file will be transcoded into the formats in your Codec 
Profile list.

If you have Stream FE you will also be able to use Batch Mode for non-real-
time encoding. Batch Mode encodes to a master file first in real-time, typically 
an uncompressed or lossless AVI file, and then automatically transcodes the 
master file to the other formats you have selected. (This is more automated 
than in Queued Mode, where you have to create the master file first, and then 
select it as an input.) 

When you first switch to Batch Mode you will be asked to open a codec profile.  
This will be the codec used to create the master file. The only restriction is that 
the codec used to create the master file must be a DirectShow file. (For 
example, an AVI or MPEG file, but not a QuickTime or DRCvideo file.) You can 
then add additional files to the Batch List. If you already had codec profiles in 
your list when you switched to Batch Mode, they will automatically be entered 
into your new Batch List.

Network Transcoding Modes
If you have access to a Digital Rapids Transcode Manager system on the 
same LAN as your Stream system, you will also be able to use Transcode 
Manager Mode and Transcode Manager Batch to send jobs to your 
Transcode Engines for network transcoding. 

Select the mode from the drop-down box at the bottom of the Codec Profile list. 
A new tab will appear after the Output tab called Transcode Mgr Mode. Use 
this new tab to give your task a label (for reference) and to give the address (IP 
address or computer name) of the Transcode Manager Server that you will use 
to manage the network transcode task. 

Note that the project must be saved before you can use it in the Network 
Transcoding Modes. Also, the directory where you are storing the input files 
and the directory where you want to write the transcoded output files need to 
be in shared locations that can be accessed by the Transcode Manager Server 
and Transcode Engines.

Generate Output Filename(s)
If you right click on the Codec Profiles at the top of the list, one of the options 
is to Generate Output filenames.  This creates output archive filename(s)  
using the codec profile name and the default output path. For example, if the 
default path is C:\StreamOutput and the current codec is a QuickTime with a 
coded profile name of ClientA, then the output archive filename would be 
C:\StreamOutput\ClientA.mov.
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Codec Profile Tips

Stream supports the following codecs:
Adobe Flash 8 On2 VP6 (video plus mp3 audio)
Ateme H.264/AVC (for use in group codec or elementary video streams)
Avid DNxHD (for use in group codec or elementary video streams)
Dicas H.263/MPEG4/H.264 (plus AMR/AAC)
Digital Rapids AVC for Web (H.264 plus audio, mp4 file or broadcast)
Digital Rapids Streaming for iPhone (H.264 and AAC in TS segments)
Digital Rapids Studio AVC (H.264 for use in group codec or elementary)
DirectShow AVI 
DPS (a Leitch/Harris format)
DRC Ancillary Data
DRC Video (uncompressed video plus timecode and other metadata)
DVCPro (DV, DVCPro 25/50, DVCPro HD)
Image Sequence (18 image formats supported)
Kakadu JPEG2000
Microsoft Smooth Streaming Encoder (for 2-pass VBR encoding)
Microsoft VC-1 (for Windows Media and Smooth Streaming Encoding)
Microsoft Windows Media (WM9, VC-1)
MPEG - MainConcept (MPEG1 and MPEG2, including D10, XDCAM)
Nero Digital AVC/MPEG4/AAC
QuickTime 
Real Media (RM 8, Helix 9, Helix 10)
Sorenson ACE (QuickTime Sorenson, MPEG4, AVC, MP3, Flash 7)
Audio only codecs:

AES
AIFF
Nero AAC (audio - AAC LC, HE, HE v2, DSBR)
Surcode AC-3 (audio - stereo or surround)
Thomson MP3
Wave (audio - multichannel)
Dolby Digital, Dolby Digital Plus, Dolby Pulse (stereo or surround)

Closed Captioning/Data (SCC, SAMI, SRT)
Group (for combining video, audio and a wrapper/processor)
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Adobe Flash 8 On2 VP6 (Optional) 
This optional codec provides Flash 8 SWF and FLV encoding.

For more information on this codec open the Adobe_Flash8_On2_Codec.pdf 
file. For more information about live broadcast using this codec open the 
Flash8_Streaming.pdf file. Both files are located in C:\Program Files\Digital 
Rapids\Stream\documents.

Ateme (AVC/H.264 - Optional for Stream FE) 
This codec can be used for H.264 elementary stream encoding, and is 
primarily used in conjunction with the Group Codec profile (see the following 
section).

For more information on this codec open the Ateme_AVC_Settings.pdf file 
which is located in C:\Program Files\Digital Rapids\Stream\documents.

Avid DNxHD (Optional for Stream FE) 
This codec can be used to create DNxHD video in VC-3 files. It is typically used 
in the Group Codec along with the MXF Processor.

Avid DNxHD VC-3 files can be captured in real time. However, some systems 
will not be able to wrap DNxHD in MXF in real time. This is a disk I/O issue, not 
a CPU speed issue, and will be resolved in a future Stream software release. 
The workaround is to encode the VC3 and audio files in real time, then to use 
the Tools > MXF Wrapper to do a post-encode wrap. The MXF Wrapper tool 
can also be used as a command line parameter to do an automatic post-
encode wrapping step. This limitation does not apply to transcoding, just to real 
time encoding.

When wrapping Avid DNxHD in MXF, use the Avid OP-Atom pattern to create 
files that can be imported into the Avid Media Composer without further 
rendering. Also, be sure to increase the Video Buffer Size to be as large as one 
frame, for example, 917504 bytes is a good value for 1080i. Note that OP-Atom 
is used to wrap MXF files with just one stream, so there will be individual MXF 
files created for the video stream and one for each mono audio stream.

Dicas (H.263/MPEG4/H.264 plus AMR/AAC - Optional) 
This codec is primarily intended for the creation of 3GPP compliant files and 
live streams. 

For more information on this codec open the Dicas_Codec.pdf file which is 
located in C:\Program Files\Digital Rapids\Stream\documents.

Digital Rapids AVC for Web (Optional) 
This codec can be used for archive file creation and/or live streaming, 
depending on your license. It includes the AVC/H.264 video codec and AAC 
and MP3 audio codec, as well as the RTP/RTMP Broadcast output.
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For more information on this codec open the DR_AVC_Web.pdf file which is 
located in C:\Program Files\Digital Rapids\Stream\documents.

Digital Rapids Streaming for iPhone (Optional) 
This codec includes the DR AVC/H.264 video codec, the Dolby Pulse AAC-HE 
codec, and a transport stream muxer. It is used to create the segmented 
transport stream files and index files required for video on demand and live 
iPhone Streaming. For more information open the DR_iPhone.pdf file which is 
located in C:\Program Files\Digital Rapids\Stream\documents.

Digital Rapids Studio AVC (Optional for Stream FE) 
This is an AVC/H.264 elementary stream codec. It can be used to make Bluray 
compatible elementary stream files, or it can be used in the Group Codec for 
live RTP streaming or muxed into an MPEG-4 file. If the Transport Stream 
muxer option has been purchased, it can be used with that muxer as well.

For more information on this codec open the DR_Studio_AVC.pdf file which is 
located in C:\Program Files\Digital Rapids\Stream\documents.

DirectShow AVI  
The DirectShow AVI codec is a wrapper that can be used to contain other 
codecs. If you install a DirectShow codec on your system, then it will show up 
in the list of available Video Compressors or Audio Compressors on the 
Stream DirectShow AVI Profile window.

This allows you to easily add DirectShow codecs to your Stream system. Some 
commonly added codecs include DivX, MainConcept DV, lossless Huffman 
YUV (HuffYUV), etc.

Uncompressed AVI
It is common to use an uncompressed AVI as a master file when you need to 
capture a master file that you can then transcode to other formats.

If you have an AVI codec profile from a previous build of Stream, and it did not 
specify the audio compressor, you will not be able to use it in Stream 2. 
Recreate the AVI codec profile in Stream 2.

DRC Video 
This is an uncompressed YUV video file that can also include timecode 
information and additional data such as closed captioning (unlike an 
uncompressed AVI file). This format does not include audio.

DVCPro (DV, DVCPro 25/50, DVCPro HD - Optional) 
This codec can be used to create dif files, but is more typically used with either 
the DirectShow AVI, or in the Group Codec with a processor (MXF, GXF, LXF).
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Image Sequence (Stream FE) 
You can enable Strobe Mode and set the time between image captures. 

For BMP files you can change the bit format from 24 bits to 32 bits.

For JPG files you can set a maximum file size or file quality.

For YUV files you can choose between YUY2 or UYVY formats.

Kakadu JPEG2000 (Optional) 
This codec creates JPEG2000 image sequences. It can also be used in the 
group codec to create MXF files that include JPEG2000 plus audio.

For more information open the Kakadu_JPEG2000.pdf file located in 
C:\Program Files\Digital Rapids\Stream\documents.

Microsoft Smooth Streaming 
This codec is a VC-1 2-pass VBR codec that can be used to make files for 
smooth streaming. It is typically used in the Group Codec along with the 
Smooth Streaming Container set to “File” mode. The resulting files can be 
played back using an IIS Server. This codec cannot be used for live broadcast 
- for live smooth streaming you must use the Microsoft VC-1 codec (see the 
following section).

Open the Smooth_Streaming_using_Digital_Rapids_Stream.pdf file located in 
C:\Program Files\Digital Rapids\Stream\documents for more information.

Microsoft VC-1 
This codec is a video elementary stream VC-1 codec. It can be used to make 
Bluray compatible elementary stream files, or it can be used in the Group 
Codec along with the ASF muxer to make files or live streams.

This codec can also be used in the Group Codec along with the Smooth 
Streaming Container for live broadcast of smooth streaming layers to an IIS 
Server. The Smooth Streaming Container can also be set to “File” mode, and 
the codec can then be used to make files for smooth streaming.

For more information on this codec open the VC1_Codec.pdf file which is 
located in C:\Program Files\Digital Rapids\Stream\documents.

Microsoft Windows Media (WM9, VC-1) 
This codec can be used to encode video and/or audio WMV files. It cannot be 
used to create elementary stream files. When you create a Windows Media 
profile, if you enable both video and audio there must be both a video and 
audio source selected in your source profile when you encode.

The latest Microsoft codecs will be installed on your system if you have the 
latest Windows Media Player installed. Otherwise, when you install Stream you 
may see an information window displayed on your system, warning you to 
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upgrade your Windows Media codec. At the same time, the Stream installer 
will copy the wmfdist_v11.exe file you need to upgrade the codec to your 
system drive. You can run this exe after the Stream installer has finished. If the 
Stream installer detects that you already have the latest codec installed, you 
will not see this information window.

There are some optional registry settings that Microsoft supports when using 
the v.11 codec. Note that these are system registry settings, and once they 
are enabled, they will affect all Windows Media encodes on the system. If you 
need to use these registry settings, please contact Digital Rapids support for a 
key to unlock this feature.

You may preserve timecode by clicking on the Video Settings button. If you 
preserve the timecode you will be able to see it in the Windows Media Player 
by selecting View > Enhancements > Play Speed Settings.

If you plan to do very long duration live streaming of WM9 (longer than 24 
hours of continuous live streaming) please contact Digital Rapids Support. 
There are known clock issues for some systems that can be corrected with the 
appropriate registry settings, and Digital Rapids can provide you with the 
appropriate settings for your system.

MPEG - MainConcept (MPEG1 and MPEG2) 
This codec can be used to make MPEG1 or MPEG2 files. It has an integrated 
muxer that can support program stream or transport stream muxing of video 
and a variety of audio formats, as well as elementary stream creation.

The MPEG - MainConcept menu has a sub-menu that gives you access to 
various pre-sets. For example, if you pick the DVD pre-set the settings in the 
Advanced window will be restricted to the settings that are used to make a DVD 
compliant MPEG2 file. 

There are some basic codec settings on the main MPEG Profile window that 
opens when you first choose the codec. You can increase the quality of your 
file by increasing the Quality setting. The default value is 30 and the highest 
value is 50.

For more information on this codec open the MPEG_Encoding_Guide.pdf file 
which is located in C:\Program Files\Digital Rapids\Stream\documents.

Some advanced MPEG2 settings tips:
To change from the default 4:2:0 sampling to 4:2:2 go to the Advanced Video 
Settings tab and change from Main Profile to High Profile. In the list on the right 
hand side click the + next to Sequence Extension, and change the Chroma 
Format value from 0 to 1.
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To change from Program Stream to Transport Stream go to the Multiplexer 
Settings tab and choose TS or one of the other multiplexor types for Transport 
Stream: CableLabs (VOD servers), DVB, ATSC (US broadcast), MicroMV, 
DVHS and HDV .

If you want to create an MPEG file that is larger than 720x480 (NTSC) or 
720x576 (PAL) go to the Advanced Video Settings tab and change from Main 
Level to High Level.

Nero Digital (AVC/MPEG4/AAC - Optional) 
The Nero Digital codec can be used to create MPEG4 Part 2 and AVC/H.264 
(MPEG4 Part 10) files. You cannot use this codec to create elementary stream 
files or for live streaming.

The MPEG4 Part 2 files are created with the Simple Profile or Advanced 
Simple Profile (depending on the pre-set that is chosen). The AVC files are 
created with the Baseline or Main Profile (depending on the pre-set that is 
chosen).

For more information on this codec open the Nero_Digital_AVC_MPEG4.pdf 
file which is located in C:\Program Files\Digital Rapids\Stream\documents.

QuickTime  
The QuickTime codec is a wrapper that can be used to contain other codecs. 
If you install a QuickTime codec on your system, then it will show up in the list 
of available codecs in the Video Compressor or Audio Compressor settings 
available from the Stream QuickTime Profile window.

This allows you to easily add QuickTime codecs to your Stream system. Some 
commonly added codec include the Avid codec pack, BlueFish444 codec pack 
and BlackMagic codec pack.

If you install QuickTime Player 7.4 (or newer) the default codec list will be 
shorter then with previous versions of the player. To show the complete list, 
open the QuickTime player, select Edit > Preferences > QuickTime 
Preferences, then select the Advanced tab, and check the "Enable encoding 
using legacy codecs" box. 

If you purchased Stream FE you will also be able to access the Apple H.264 
video and AMR and AAC audio codecs. These codecs cannot be accessed 
through Stream LE.

Uncompressed QuickTime
To create an uncompressed YUV QuickTime file choose a video compression 
type of “None”. This will cause the Stream software to bypass the QuickTime 
file writer provided by Apple (which is inefficient on a PC), and cause it to use 
the Stream file writer. Note that if you later import this uncompressed YUV file 
into Apple Final Cut Pro you will need to render the files on the timeline.
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Real Media 
If you want to create a Real 8, 9 or 10 profile, we recommend you use the Helix 
10 Profile and then choose the video codec from the drop-down menu on that 
page. However, if you need to create a file using the much older RealVideo G2 
with SVT codec, then you will need to select the Helix 9 profile.

When creating a Real Helix codec profile you must add at least one Audience 
by clicking the blue + button. You can then select that Audience and click on 
the Edit button (the button with the pencil icon) to change the frame rate and 
to make codec adjustments.

Sorenson ACE (optional) 
If you have Sorenson ACE you can use it to create MPEG4, AVC (H.264), 
QuickTime, Flash 7 and MP3 codec profiles. To adjust the settings for your 
codec profile choose a media type, then highlight the video stream or audio 
stream that you want to adjust (by selecting the data rate for the stream) and 
then click the Edit button (with the pencil icon) to open a settings window. Note 
that a frame rate of -1 means 1 source frame to 1 destination frame, and of -2 
means 2 source frames to 1 destination frame (half the source frame rate). To 
see more settings click on the Codec Settings button.

Sorenson ACE is not supported on Windows Vista.

Audio Only Codecs:

AES Audio 
This audio codec is used within the group codec along with the MXF processor.

AIFF Audio 
This codec can be used to make multichannel audio files. It’s primary use is for 
creating audio files that can be wrapped with MPEG2 in the Omneon MOV file 
wrapper.

Dolby Digital (AC- 3 audio - Optional) 
This codec can be used to create AC-3 files or streams. These are typically 
muxed into a Transport Stream and/or used in the Group Codec with a 
processor. Stereo only and Surround options exist for this codec.

For more information on this codec open the Dolby_Digital_Settings.pdf file 
which is located in C:\Program Files\Digital Rapids\Stream\documents.

Dolby Digital Plus (EC- 3 audio - Optional) 
This audio codec is an enhancement to the Dolby Digital codec. It supports 
both Stereo and Surround. This format is typically used for BluRay authoring 
or in an mp4 file.
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For more information on this codec open the Dolby_DigitalPlus_Settings.pdf 
file which is located in C:\Program Files\Digital Rapids\Stream\documents.

Dolby Pulse (AAC audio - Optional) 
This codec can be used to create AAC files or streams. It can be used with the 
Group Codec profile along with a muxer. It is also included in the Dgital Rapids 
for Web and Digital Rapids Streaming for iPhone codecs.

For more information on this codec open the Dolby_Pulse_Settings.pdf file 
which is located in C:\Program Files\Digital Rapids\Stream\documents.

Nero AAC (audio - optional) 
This codec can be used to create audio files (using the ADTS stream type) or 
as an elementary stream in conjunction with the Group Codec profile. 

When using Nero AAC as an elementary stream within the Group Codec 
profile use the ADTS stream type when making an MPEG2 Transport Streams 
or MPEG-4 files. You can also use the ADTS stream type for RTP streaming.

Thomson MP3 (audio - Stream FE) 
This codec can be used to make mono, stereo or surround MP3 files. It is also 
included with the Adobe Flash 8 codec as the included audio codec (mono or 
stereo only with Flash 8), and with the Digital Rapids AVC for Flash 9 codec.

WAV and Broadcast WAV (multichannel audio) 
This codec can be used to make mono, stereo, or user-defined multichannel 
audio files. It uses the RF64 extension to allow the creation of WAV files that 
exceed the 2GB WAV file limit, however, not all players will be able to play back 
WAV files that are bigger than 2GB.

Closed Captioning/Data (SCC, SAMI, SRT, DFXP) 
These codec profiles can be used to capture the closed captioning data from 
line 21 of live NTSC sources. 

SCC (Scenarist Closed Caption) files were designed to be used for DVDs. 
Normally you will choose Field 1 (includes CC1 and CC2 data) and you will 
enable Drop Frame. (Field 2 includes CC3 and CC4 and is rarely used).

SAMI files (Synchronized Accessible Media Interchange files) were designed 
by Microsoft to be used for multimedia files. Normally you will choose CC1 as 
the channel, but CC2 is also available.

SRT (SubRip Subtitle Format) files are used to store timecode and text. They 
are commonly used for subtitles, but can also be used as a source for Timed 
Text for MP4.
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DFXP files are used to store 608 and 708 closed captioning. You cannot use 
Stream to create these files, however if you have a DFXP file you can use it as 
a closed captioning input file for some codec profiles.

Group Codec Profile
The group codec profile is used when you need to use more than one basic 
codec profile to create a video and audio elementary stream, and you then 
need to process those elementary streams (or wrap them) into a single output 
file or live stream. 

For example, if you are making an H.264 VOD file, and the output must be 
delivered in a Transport Stream, then you will need to use an H.264 codec and 
an audio codec and a Transport Stream muxer to generate the final output file.

Currently, the following types of group codec processors are supported: 

• ASF Muxer for use with Microsoft VC-1 
• Elementary Stream File
• GXF Wrapper for creating Grass Valley/Thomson server files
• LXF Wrapper for creating Leitch/Harris server files
• Manzanita Transport Stream Muxer for delivering VOD files and live 

transport streams
• MOV Muxer for creating QuickTime files that cannot be processed by the 

regular QuickTime codec profile: MPEG2 D10 (IMX), DVCPro, Digital 
Rapids Studio AVC (H.264)

• MPEG-4 Muxer for combining AVC and audio into a file
• MXF Wrapper for creating MXF files
• Native RTP for delivering live RTP/RTSP streams and RTMP streams
• Smooth Streaming Container for creating files and live streams
Each one of these processors accepts specific codecs as elementary video 
and elementary audio input types.
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To create a new group codec profile, select Codec Profile > Create > Group.

To set up a group codec start by creating a new processor in the left hand 
panel (by clicking the button with the “new page” icon) or adding one you had 
previously created (by clicking the button with the blue + icon). When you add 
a new processor, the processors currently enabled by your license will appear 
in a list. 

ASF Muxer 
The ASF Muxer can be used to create ASF streams for delivery to a Windows 
Media Server, or to create ASF archive files. Use the VC-1 video codec and 
the Windows Media Audio codec as elementary streams for this muxer.

Elementary Stream File
The Elementary Stream File processor can be used to create a video or audio 
elementary stream file. Normally you will use the group codec to create files or 
broadcast streams that combine video and audio, but there may be times when 
you also want to save the elementary streams in addition. This processor 
allows you to feed the same data stream that you are using in other processors 
to an elementary stream file, thereby eliminating the need for another encoded 
data process (with its corresponding CPU usage).
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When using this processor, be sure to change the file extension from the 
default .ES to one that is appropriate for your elementary file.

GXF Wrapper
The GXF Wrapper is used to create files used by a Grass Valley/Thomson 
server. These files can contain MPEG1, MPEG2 or DVCPro video, plus 
PCM/WAV audio.

LXF Wrapper
The LXF Wrapper is used to create files used by a Leitch/Harris server. These 
files can contain MPEG1, MPEG2 or DVCPro video, plus PCM/WAV audio.

Manzanita TS Muxer
The Manzanita transport stream muxer can be used to deliver the video and 
audio elementary streams in an MPEG2 transport stream. The muxer has 3 
“levels” of settings, the Transport level, the Program level, and the media level 
(for your video and audio elementary streams). Each level has its own settings. 
When you click on an item at a particular level you can access its settings in 
the panel to the right.

Once you add the Manzanita TS processor to the Group Codec Profile, clicking 
on an individual media stream (video or audio) inside the processor will open 
a drop-down box that will show you the codec that can be used by that media 
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type. If you have not yet added any codec profiles to the Group Codec Profile, 
the drop-down box will be blank. However, information about the type of input 
that the media type accepts will be shown at the bottom of the panel.

For more information about this processor open the Manzanita_TS_Muxer.pdf 
file which is located in C:\Program Files\Digital Rapids\Stream\documents.

MOV Muxer 
The MOV Muxer can be used to create QuickTime files that cannot be created 
using the regular QuickTime Codec Profile. These files contain MPEG 2 D10, 
or DV/DVCPro or AVC/H.264 plus audio.

MPEG-4 Muxer
The MPEG4 Muxer can be used to create several file types that are all based 
on the ISO/IEC 14496-12 standard (mp4, 3gp, f4v, f4a, mov, m4v, m4a).

For more information about this processor open the MPEG4_Muxer.pdf file 
which is located in C:\Program Files\Digital Rapids\Stream\documents.

MXF Wrapper
The MXF wrapper can be used to combine video and audio streams into an 
MXF file. Many operational patterns are supported, with the most common 
being Op1A, IMX and eVTR.

The processor has 3 “levels” of settings: Container (where you define the 
operational pattern), Program (a grouping of video and audio essences), and 
the Video and Audio essence layer (where you define the type of media being 
used). Each level has its own settings. When you click on an item at a particular 
level you can access its settings in the panel to the right by selecting the 
parameter and then clicking the Change button.

Note that if you have already encoded video and audio files that you need to 
wrap in MXF, you can do so without re-encoding by using the Tools > MXF 
Wrapper option from the main Stream menu.

Native RTP
The Native RTP processor can be used to stream video and audio packets as 
native RTP data. The only settings for this processor are the names used to 
store the processor, and the names used for the video and audio stream. 
These names are for your reference only, and will not affect the RTP data.

Server setup is done on the Output tab, by activating and clicking the 
Broadcast button.
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Smooth Streaming Container 
The Smooth Streaming Container is used to make the files used by a Microsoft 
IIS Server for smooth streaming file based or live delivery.

You must set the container to the correct Output Format mode, File or Live, as 
different types of file will be created depending on this setting. You must also 
select the corresponding output type, Archive or Broadcast, on the Output tab.

If you are using this container with the Microsoft VC-1 codec you must add a 
Video program for each smooth streaming layer.

If you are using this container with the Microsoft Smooth Streaming codec then 
you will only need one video program defined in the container, and the 
individual layers will be specified in the codec.

Open the Smooth_Streaming_using_Digital_Rapids_Stream.pdf file located in 
C:\Program Files\Digital Rapids\Stream\documents for more information.

Smooth Streaming encoding is only officially supported on the following 
Operating Systems: Windows Vista, Windows 7, Windows Server 2008.

Adding Codec Profiles to the Group Codec
On the main Group Codec Profile window, the panel to the right is used to add 
the codec profiles that will be available to your processors. You can add a new 
codec profile (by clicking the button with the “new page” icon) or adding one 
you had previously created (by clicking the button with the blue + icon). When 
you add a new codec, the codecs that you are licensed for that are currently 
supported by the group codec will appear in a list. The codec profiles you 
create or add here will appear in the codec profiles list in the left hand panel.

Once you have added a processor and codec profiles, the appropriate choices 
will appear in the Processors panel on the left, in the drop-down boxes that 
appear when you select a video or audio stream for the processor.
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Editing a Group Codec Profile
Once you have created a group codec profile, you will see it in the main Stream 
interface in the codec profiles list. To edit the group codec profile, right click on 
the group, and then select Adjust Profile Settings.

This will re-open the main Group Codec Profile window, and you can then 
select a processor or a codec and click the edit button (the button with the 
pencil icon) to open the settings window for the selected item.

Output for a Group Codec
File output (Archive) or live streaming output (Broadcast) for a group codec are 
two of the available output options when you choose a group codec processor. 
Note that some of the group processors only support Archive (file creation), 
some only support Broadcast (live streaming) and some support both.

Additional output options can be selected if you choose the “root” of the Group 
Codec, as shown in the following image.

The output options are explained in more detail in “Output” on page 48.
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Input
The Input tab is where you set your input type. 

Clips for Transcoding
Media Files
Image Sequence File Source (Stream FE)
Watch Folder (Stream FE)
Clip List (Stream FE)

Video Input
Live Source
Deck Control (Stream FE) 
DV Input (DRC-1600 and 2600 boards only)

Clips for Transcoding
These input options allow you to input clips that can be transcoded to other 
formats.

Video Preview (for Clips for Transcoding)
When using these input modes you can play your video file by clicking on the 
Monitor Source button, the blue “play triangle” found in the main toolbar. You 
can see some options for the video preview using the main menu’s Video 
Preview. These affect the preview only, not the final encoded file. Note that the 
video preview is sensitive to the codec profile that you have currently selected.

Loading a Media File
Use the Media drop down box to specify whether your media contains video 
and audio, or just video or just audio. 

Note that if you load a media file that contains video and audio it will be loaded 
into both the video and audio sections of the window. If you load a media file 
that contains video in one file and audio in another (such as a DPS/DVA file or 
DRCvideo/WAV file) you will have to load the video and audio separately.

You can also use more than one audio file for your source. Click the “+ Audio” 
button to add another audio file chooser in the audio area. When you are using 
multiple audio files it will also be common to use an “Audio Channel 
Remapper/Selector” plugin to assign the channels of the audio input files to the 
output channels used by the codec.

Once you have loaded a media file, under the filename you will see the format 
that was detected by Stream for that file.
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To the right of the Filename field you will see a drop-down box. This can be 
used to force Stream to treat the file you have selected as a specific file type. 

For video your choices are: Auto, DirectShow, Windows Media, QuickTime, 
DRC Video, DPS, MXF, GXF and Red Camera (where MXF, GXF and Red 
Camera source imports are licensed options).

For audio your choices are: Auto, DirectShow, Wave file, QuickTime, 302M 
Audio, Pinnacle Audio, Windows Media, MXF and GXF (where MXF and GXF 
source imports are licensed options)

Note that if you are using MPEG2 files with 302M Audio or Pinnacle Audio, two 
audio types used in MPEG2 broadcast formats, you must choose them 
manually as they will not be detected automatically in an MPEG2 file.

Multichannel Audio Files
Note that under the Audio type selection drop-down box there is a Settings 
button. Click this button to open a window that will allow you to select which 
audio channels will be used when you are transcoding the file. For example, if 
you are encoding a file with 4 audio channels to a file with 2 audio channels, 
you will be able to pick which of the 4 audio channels will be transcoded to the 
new file.

You can also use audio Plugins to select which channels to use, to mix-down 
audio, and to adjust levels during a transcode.

Trimming a Media File 
When you choose Media File as an input type you will see a Trimming section 
to the right. You may specify an in point and a duration. This may be specified 
in timecode or in seconds (to the nearest second). Use the small button to the 
right of the timecode to specify the frame rate of the source file. Note that if this 
frame rate does not match the frame rate of the source file, this will not change 
the frame rate of the transcode, it will simply show the incorrect timecode.

When you start transcoding the file, Stream will only be able to “seek” to the in 
points for DirectShow media files. For other media file types, Stream will start 
generating data right from the beginning of the file, but it will not write any of 
that data to your transcoded file until it reaches your in point. This could result 
in a significant delay before Stream reaches your in point if you plan to encode 
the last few minutes of a long file. 
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Image Sequence File Source (Stream FE)
These are numbered image files typically produced by an animation program.  
Add the image sequence files and specify a frame rate for the transcoded 
video. You can also add an audio file (such as wav or mp3) if you want your 
encoded video to have a sound track.

Watch Folder (Stream FE)
When you select Watch Folder as an input, you will be able to select a folder 
on your system, and every time a file is dropped into this folder it will be 
transcoded and any output options you have set on the Output tab will start 
automatically.

For example, you may want people to drop files into the folder, to have them 
made into a single video file, and then to have the file automatically sent to a 
client using the Email function. Or you may want people to drop files into the 
folder and then to have those files transcoded individually, and to be uploaded 
to an FTP server as the transcoding is completed.

If you have one specific type of file that you want to use as an input file type, 
you may manually select the Video and Audio type, and which audio channels 
to use for the transcode (much as you can when using a Media File input type).

If you have a mixture of file types for your Watch Folder, you should leave the 
Video and Audio type set to Auto. Keep in mind that this will not work for some 
file types, such as MPEG2 files with 302M audio for example, where you must 
specify the audio type.

You can add media files and data files to Watch Folders. For example, you can 
add some video files which you do want to transcode and some data files you 
cannot transcode (e.g., exe files, txt files) but that you do want output (for 
example, to upload to your FTP site with the transcoded video). Files with file 
extensions that are not recognized as video or audio media files will use output 
functions without being transcoded. If you want to use Watch Folder to manage 
video files but you do not want to transcode these files before transmitting 
them, you can add the files to a zip file before dropping them into the Watch 
Folder.

When you select Watch Folder you must select an individual folder to watch for 
files. Be sure to select the folder, and not to accidentally double click on the 
folder, which will create a sub-folder which you may not be expecting.

If you will be using a numbered sequence of files, for example an image 
sequence (Logo001.tga, Logo002.tga, etc.) or a numbered sequence of clips 
(clip01.avi, clip02.avi, etc.), you can also choose to transcode the files to a 
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single video file before transmitting the file.  To accomplish this, check the 
"Output to single file" box.  You will then be able to fill in all of the numbered 
file information.

If you want the input files to be deleted after they have been transcoded into 
their delivery format, check the box at the bottom of the window. Note that files 
that are not transcoded before they are delivered (e.g., exe files, doc files, etc.) 
will not be deleted after they are transmitted.

When you are creating a single output file from multiple input files, you may 
click the Stop button before you have added the last file (as defined by the End 
at box) to the Watch Folder. When you click the Stop button Stream will stop 
transcoding the files and will start any additional output options you have set 
on the Output tab. Otherwise the transcoding will continue until the ‘End at’ 
number of files has been reached, and then Stream will start any additional 
output options you have set on the Output tab. 

Persistent Watch Folder 
You can set up a project with a Watch Folder as a “persistent” project. That 
way, should the power be lost, when your computer starts up Stream will be 
launched, the project with the Watch Folder will be loaded, and the Watch 
Folder will be active and ready to accept files. This tool can be found in the 
main Stream menu under Tools > Persistent Watch Folders.

Clip List (Stream FE)
When you use Clip List as an input type you will be creating a list of clips that 
exist on your system. You can then choose to transcode each clip on the list to 
another file format (or formats).  Note that you can only use single pass codecs, 
not 2-pass codecs, with the Clip List function.

You can also choose to combine all of the clips in the list into a single clip by 
enabling the Concatenate output checkbox.

If you have one specific type of file that you want to use in your clip list, you 
may manually select the Video and Audio type, and which audio channels to 
use for the transcode (much as you can when using a Media File input type).

If you have a mixture of file types for your clip list, you should leave the Video 
and Audio type set to Auto. Keep in mind that this will not work for some file 
types, such as MPEG2 files with 302M audio for example, where you must 
specify the audio type.
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Video Input

NTSC/PAL Standard for SD Boards
When your Digital Rapids SD hardware was installed it was set to NTSC or 
PAL. You can switch video standards by selecting Options > Preferences from 
the main menu, and then selecting the Hardware tab. If you have SD hardware 
and are going from PAL to NTSC you will have to re-start your drivers (by re-
booting your computer for example). This does not apply to HD hardware, 
which detects the input standard automatically.

Video Preview (for Live Source or Deck Control)
When using Live Source or Deck Control you can see your video input by 
clicking on the Monitor Source button. You can see the options for the video 
preview using the main menu’s Video Preview. These affect the preview only, 
not the final encoded file. Note that the video preview size is sensitive to the 
codec profile that you have currently selected.

Persistent Streaming
Persistent Streaming is used to launch Stream with the selected project loaded 
and encoding as soon as the system is booted. Typically this is used to allow 
for recovery from a power loss during a live encoding session to a web 
streaming output. This will allow Stream to return to live streaming mode 
almost as fast as the system can boot (usually about 1 minute). To use 
Persistent Streaming mode you must have previously saved the project you 
wish to use. 

To configure Persistent streaming mode choose the Tools > Persistent 
Streaming from the main menu. You will be able to add the current project or 
delete a previously created Persistent Streaming project.

Live Source
If you have a live video source connected to your Digital Rapids hardware, for 
example a camera, a tape deck, a DVD player, etc., you can encode the live 
source to a file. After you select Live Source as an input type, you will need to 
create a Source Profile, which specifies which video and audio inputs to 
monitor. Click the Create Source Profile button to open the Source Profile 
window.  
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Source Profile for SD Boards
(For DRC-500 to DRC-2600)

Select a video source and an aspect ratio.  

For the DRC-500, in the audio section highlight an audio channel and then click 
the Edit button.  Click the enable audio processor and you will then be able to 
use the Source drop down box to select the type of audio you are using.  Click 
OK to enable your audio selection.  Click the Save button to save your Source 
Profile and to add it to the Source Profile’s drop down list.  

For the DRC-1000 to 2600 you will see an Edit button in the audio section. 
Click that button and an audio selection window will open. Select the audio you 
want to assign to the 4 stereo audio channels and click ok. Note that if you want 
to select 2 SDI pairs from one SDI input you must click the SDI button twice.

If you added more than one audio channel to your Source Profile, you can 
select which one you want to encode on the main interface’s Input tab by using 
the drop down box in the Audio section of the Input tab. (For reference, see the 
graphic at the end of the following section on HD Boards.)

Source Profile for HD Boards
(For DRC-5550 to 5650)

Video:  For Live Source, there is only one video input, the SDI input.  

The Video section of the source profile window tells the hardware what to do 
to the video input before it is passed on to the codec profiles for encoding.  The 
things that can change are:

Bit/Data Format: Choose between 8-bit UYVY and 8-bit YUY2 

Conversion: 
• None (do not convert the frame size or frame rate); When you select None 

you will be able to specify how many SD lines you want to capture. This 
allows you to capture VBI lines, so that you can capture closed captioning 
information for example. For NTSC you can choose 480, 486 or 512, for 
PAL you can choose 576 or 608.

• Automatic (do not convert the size but provide options to convert 
progressive/interlaced, frame rate, and aspect ratio)

• Custom (provide options to convert all settings, including frame size). 
Generally, the source profile’s frame size should be as large as the largest 
dimension used by the codec profiles you have added to your project.
 



Digital Rapids Stream Software
• List of the normal SD and HD sizes and frame rates. Note that when you 
pick one of the pre-set conversion types there will be a drop down box active 
in the Frame rate section that controls whether the frame rate is an Integer 
(e.g., 30) or Fractional (e.g., 29.97) or Automatic. If you pick Integer all 
frame rates shown in the list will be integers (except for NTSC, which is 
always fractional), and if you pick Fractional all frame rates shown in the list 
change to fractional frame rates (except for PAL and 25 fps based frame 
rates, which are always integers).

Aspect Ratio: 
The aspect ratio used by the incoming video (as a basis for the conversion) and 
the aspect ratio that it is converted to by the hardware (if any conversion is 
done).

Any video changes defined in the source profile are made in hardware. Note 
that the codec profiles can also change the dimensions, interlaced vs. 
progressive, and the aspect ratio in software.  However, if you know you want 
to format convert from the input video to a different output format you will find 
the hardware format converter will give you faster and higher quality results.

Audio:  
The DRC-5550 to 5650 board has 4 stereo AES inputs and embedded SDI 
audio inputs.  

In the Audio area of the Source Profile window click the Configure button.  You 
can add the AES inputs by clicking on the numbered AES graphic that you 
want to add.  You can add the embedded SDI audio by clicking on the SDI 
graphic and then selecting the SDI group and pair.  To add another SDI audio 
group or pair click on the SDI graphic again.  To remove an audio input 
highlight the input and click the Delete button.

Once you have finished selecting all settings click OK to return to the main 
Source Profile window. Give your Source Profile a name and then click OK to 
save the source profile.

Once you have closed the Source Profile window, if you have previously added 
a codec profile to your project, you will see the audio inputs you have selected 
in your source profile in the audio section of the Input tab. Click on the Audio 
Source and on the Channel in the audio section of the input tab to change the 
audio inputs being used by the currently selected codec profile.
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Additional Input Settings
Timecode for Live Source 
If you want to preserve timecode in your file, you can choose from a variety of 
timecode options. Note that the codec profile must support timecode.

• None: do not preserve timecode
• Auto-Increment or Time of Day: For Auto-Increment you specify a starting 

timecode and the timecode will count up automatically. For Time of Day 
your system’s clock will be used to generate the timecode.

There are two additional timecode modes available when you are using Deck 
Control. These two modes are used to write continuous timecode to a file, even 
when the source has timecode breaks. (See the Deck Control Section.)

The following additional timecode options are available for the HD board 
(DRC-5550 to 5650):

• SDI VITC1 (VITC timecode embedded in the SDI signal)
• SDI VITC2 (VITC timecode embedded in the SDI signal)
• SDI LTC (LTC timecode embedded in the SDI signal)
• LTC In (LTC timecode from the LTC input on the breakout box)

Black Border 
For DRC-500 to DRC-2600: If you want to add a black border to your video, 
“squeezing” your video into the active video area inside the black border, you 
can click the Black Border button.
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For DRC-5550 to 5650 you can use the Border plugin. (See the Plugins 
section.)

Capturing VBI Lines for Closed Captioning
VBI lines are typically used by SD video to carry a variety of data, including 
closed captioning (NTSC) and Teletext (PAL) data. HD closed captions are 
typically carried in the SDI ancillary data, although some HD decoders may 
place that captioning data on line 9 for analog HD TV.

For DRC-1000 to DRC-2600:
When you are capturing video you can capture vertical blanking interval data 
to preserve closed captioning data. (Note: The DRC-Stream 500 hardware 
cannot capture VBI data.) 

1) On the Input tab select your input: Live Source or Deck Control.

2) On the Input tab enable the “Use external video timing” option. On the Video 
Process tab you will normally disable the “Enable deinterlacing” option, 
although this is not required.

3) On the Input tab click the VBI button and enable VBI. Depending on your 
playback device, you may need to capture different numbers of VBI and Black 
border lines. You may also choose to capture the VBI lines as part of the video 
frame, or you may enable the “Exclude from frame” option if you want to use 
the VBI data to create an SCC or SAMI file but you do not want to include the 
VBI lines in your frame for other codec profiles.

Capturing VBI data and including it in the frame 
The following method is supported by the Vela playback hardware. Depending 
on the playback device you are using, the exact method may vary.

Follow the first 3 steps above.

4) On the Input tab click on the VBI button (if you closed the window in the 
previous step).

For NTSC set start line 21 and number of lines to 2. 

For PAL set start line 15 and number of lines to 8.

Click OK.

5) On the Input tab click the Black Border button. 

NTSC: set the Top to 26 and the bottom to 2. PAL: set the bottom to 16.
 29 

 
• 
• 
•
•
•



30 

 
• 
• 
•
•
•

Digital Rapids Stream Software
6) Click the Monitor Source button. You will notice the VBI lines with the closed 
captioning information at the top of the frame. (If you were already monitoring 
the source you may need to toggle it off then on again to see the VBI.)

7) Select Codec Profile > Create to create your codec profile. Include the 
Closed Captioning VBI lines and black border lines in the profile. For example:

NTSC: If it is a WM9 profile set it to 720 x 512 (for NTSC). 

NTSC: If it is a MPEG2 profile use the Advanced Settings button and then 
select the Advanced Video Settings. Change the “Profile ID” to High Level. 
Click OK to return to the main MPEG Profile window, and set the frame 
size to 720 x 512.

PAL: If it is a MPEG2 profile use the Advanced Settings button and then 
select the Advanced Video Settings. Change the “Profile ID” to High Level. 
Click OK to return to the main MPEG Profile window, and set the frame 
size to 720 x 608.

8) Set an Output file name and then click Start to encode your video clip.

If you used the settings outlined above you will be able to use the “Closed-
Captioning Decoder” (available as a short cut in your Start > Programs > Digital 
Rapids folder). This will allow you to verify that there is closed captioning data 
in the live source and that there is closed captioning data in the encoded file. 
Note that it is intended to be used as a verification tool rather than to produce 
an accurate log of the text.

Note: Depending on your specific playback device you may have to adjust the 
number of VBI lines you are capturing, and then number of Black Border lines 
you need to “pad” your video frame.

Capturing VBI data and excluding it from the frame
If you enable the VBI and you exclude it from the frame, you will still be able to 
capture the VBI data in a SCC or SAMI file, or directly in the user defined data 
in an MPEG2 file (as set by the MPEG2 codec profile).

Note that the closed captioning in the MPEG2 data is the type of closed 
captioning required for broadcast (608/708). It is not the type of closed 
captioning required by DVDs. In order to add closed captioning to your DVD 
you will have to make an SCC file and use your DVD authoring software to 
include the closed captioning in your DVD.

Closed Captioning for DRC-5550 to 5650 SD SDI
For the DRC-5550 to 5650, the SD VBI data can be passed on to the codecs 
without including it in the video frame by enabling the “enable VBI follow” 
checkbox on the Input tab. You can use the VBI data to preserve closed 
captioning data using SCC, SAMI and MPEG2 codec profiles.
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If you want to include the VBI data in the frame, you can do so using the source 
profile. In the Source Profile choose “None” as your Video conversion type. For 
NTSC you can choose to capture 480 or 486 or 512 lines. For PAL you can 
choose to capture 576 or 608 lines. 

Note that you cannot use hardware format conversion if VBI capture is 
enabled.

Upres Mode for DRC-500 to 1600 (Single Stream Mode)
You can start Stream in Upres mode and that will allow you to capture more 
than the default lines. This may be useful for example, if you need to capture 
720x486 instead of the board’s default 720x480 (for NTSC).

The DRC-500 can capture up to 800x600. The DRC-1000 to 1600 can capture 
up to 1024x768. 

To use the board in Upres mode create a Stream shortcut on the desktop and 
edit the shortcut properties in the Target field to read "C:\Program Files\Digital 
Rapids\Stream\Stream.exe" -singlestream. Launch the Stream application 
using this edited shortcut. You will be asked to enter the desired frame size 
when you create your output profile.

Deck Control
The Deck Control input type is standard with Stream FE and an option for 
Stream LE. You will be able to use Deck Control if your deck is equipped with 
RS422 control (using the Sony protocol). Stream cannot control a deck using 
IEEE-1394 (Firewire) control. Connect your VTR to your computer’s serial port 
using a RS422 to RS232 converter. If you have the DRC-5550 to 5650 board 
you can also use the RS422 port on your breakout box instead of the RS232 
port on your computer.

Select Deck Control as your input type, and the Deck Control window will open.  

Deck Configuration  
On the Deck Control window select Options > Configure from the menu. Click 
the New Configuration button to set up the deck configuration.  Select a COM 
port, a Timecode Source type (LTC or VITC), and a preroll time for your deck 
in seconds.  When you click OK you will be asked to save a Deck Configuration 
Profile. You can edit your setting later by clicking on the Edit (pencil icon) 
button or delete a deck configuration from the list by using the Delete (red x) 
button. Once you have created a Deck Configuration Profile it will appear in the 
drop-down list.
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If you notice that your deck is consistently off by a few frames you can use the 
Advanced Settings button on the Deck Configuration window.  You will be able 
to select a Timecode offset by the number of frames that your deck is off.  If 
you are using some types of RS422 adapters (e.g., a DV LANC adapter) and 
the  deck control window is having trouble reading timecode from your deck, 
you will be able to correct the problem by using the “Set a time limit between 
consecutive queries to the timecode” check box and to specify a time in 
milliseconds. (For the DV LANC adapter a time of 5 ms corrects the problem.)

Changing Settings 
If you need to change the Source Profile (the video and audio inputs) for your 
Deck Control, or any of the other options on the Input tab, you can do so 
without closing the Deck Control window. Simply drag it out of the way.  If you 
do close the Deck Control window you can re-open it by clicking the Show 
Deck Control Window button at the bottom of the Media Selection tab’s 
window.

External Timing 
For the DRC-500 to 2600, on the Input tab you will also see a “Use external 
video timing” check box.  Enable this to lock your video timing to your video 
input for frame accurate deck control. You must also turn off deinterlacing for 
frame accurate deck control. If deinterlacing is enabled you will be off by 
approximately one frame. (This does not apply to the DRC-5550 to 5650 
board.)

Create a Capture List Using the Logger 
To create a capture list, click the Logger button. If you have not yet configured 
the deck you must close the Logger and use the Deck Control’s Options > 
Configure menu item, then re-open the Logger 
to connect to the deck. Use the tape transport 
buttons to play/stop/pause the tape. Use the 
jog forward/jog back buttons to move frame by 
frame. Use the rewind and fast forward 
buttons to move through the tape quickly. Use 
the eject button to eject the tape. Under the 
timecode box is a slider. You can use this to 
shuttle through the tape. 

Note that many of the buttons have keyboard 
shortcuts for ease of operation. 

For each clip you must enter an in-point, out-
point, and/or duration (you must enter 2 of 
these to define the clip). You must also enter a 
clip name and a reel name. The clip name will 
be automatically incremented after you click 
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the Add button. If you enter a clip name that includes a number, such as 
Clip001, then the clip name will be automatically incremented including the 
padded zeros. A comment may also be added. If you want to edit an item in 
the list, you can select the item and then click the Edit  button.

When you exit the Logger you will be asked if you want to save the changes. 
If you say yes any clips which have been marked with a check mark will be 
added to the Deck Control clip list, overwriting the existing list. Any clips which 
do not have a check mark will not be added to the Deck Control clip list. You 
may multi-select clips in the Logger and use the Mark and Unmark buttons to 
affect all of the selected clips. If you say no the Logger will be closed without 
adding the list or any changes to your list to the Deck Control list. Any changes 
you have made to the list will be lost.

Once you have added your Log to the Deck Control window you can save the 
list with the File > Save menu item. If you have a list that you saved previously 
you can append it to the current list using File > Append.

On the Input tab you will see a Select Capture Profile button. If you have 
previously created a capture list using the Logger you may click this button to 
open a list from the CaptureProfiles directory.

Timecode 
If you want to add timecode to your file, you can choose from a variety of 
timecode options. Note that the codec profile must support timecode.

The timecode options are the same as when you select “Live Source” as your 
input type (see “Timecode for Live Source” on page 28), with the addition of 
two more modes which are specific to Deck Control. These two additional 
modes are used to write continuous timecode to a file, even when the source 
has timecode breaks.

• Tracking - Duration: The starting timecode is used and the timecode 
increments upwards until the clip duration has been reached (the outpoint 
timecode in the capture list is ignored).

• Tracking - Outpoint: The starting timecode is used and the timecode 
increments upwards until the marked outpoint has been reached (the clip 
duration in the capture list is ignored).

Other controls found on the Input tab when Deck Control is selected are the 
same as the ones found when Live Source is selected as an input type.
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FLEx Files, ALE files, and CMX 3600 Files
You can import or append a FLEx file, an Avid Log file, or a CMX 3600 EDL 
files in the Deck Control window by selecting File > Append, and then changing 
the “Files of type” drop down box at the bottom of the Open window to “FLEx 
(*.flx)” or “Avid Log (*.ale)” or “All Files” (for the CMX 3600 EDL file).

When the file is imported or appended, it will be converted to the Digital Rapids 
xml capture log format.

Using the Logger as a stand alone tool
You can also install the Logger as a stand alone tool on a system without 
Digital Rapids hardware. When the Logger is run as a stand alone tool it will 
have its own Configuration button and File > Save As/Open menu.

Audio Levels and Audio Process
The Audio Levels tab includes sliders for Volume control. The C button above 
each slider returns the slider to its default position of 0 dB.

There are an Audio VU Meters and Audio Mute button available in the main 
tool bar. If you click on the VU Meter button it will open a full sized VU Meters 
window. The VU Meters give you a visual indication of the loudness of the 
audio signal. If you turn up the volume control sliders, the VU Meters will show 
the audio signal increasing. Always make sure that they audio signal does not 
hit the top of the scale, as that will cause digital clipping which will be clearly 
audible. As is standard for Digital VU meters, the top of the VU Meter scale is 
marked as 0 dBFS (dB Full Scale).

The Audio Process tab will only appear when you are using a standard 
definition board (DRC-500 to DRC-2600) and are using Live Source or Deck 
Control as an input.

Some codecs can only handle one audio input (mono or stereo) while some 
can handle multichannel audio. You select the audio source that will be used 
by the codec on the Input tab. Which ever audio source you highlight on the 
Input tab, a corresponding Audio Process # tab will appear.

The second set of sliders are for Bass and Treble control.

To the right you will see two graphs, one for EQ and one for Dynamic Range 
Compression/Expansion. Clicking on a graph will open the controls for the 
respective function.
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Using EQ 
This feature is available for the DRC-500 to DRC-2600 boards. It is available 
during video capture from a live source or deck control.

The EQ window has two dB vs. frequency graphs. The one on the top shows 
you the effect of currently selected EQ band. The one on the bottom shows you 
the cumulative effect of all of your EQ band’s settings. There are seven bands 
that you can control. You can activate a band by clicking on the EQ button to 
the left of the main slider. Each band can be set to a mode using the drop down 
box at the bottom of the slider:

EQ – This is a notch controller, where you raise or lower the dB of a 
frequency range and control the range of frequencies affected.

Shelf Low – Raise or lower the dB below the frequency you set

Shelf High – Raise or lower the dB above the frequency you set

Butterworth Low – cuts off the frequencies above the frequency you set. 
This cut off is a gradual curve. The  frequency you set is the – 3 dB point.

Butterworth High – Cuts off the frequencies below the frequency you set. 
This cut off is a gradual curve. The  frequency you set is the – 3 dB point.

Using Dynamic Range Compression/Expansion
This feature is available for the DRC-500 to DRC-2600 boards. It is available 
during video capture from a live source or deck control.

This feature is useful when you are dealing with audio with very loud and/or 
very quiet sections, and you want to automatically adjust these extreme 
sections to produce a more consistent volume.

Below Threshold Ratio (in:out): adjusts the gain applied to low volume signals

Above Threshold Ratio (in:out): adjusts the gain applied to high volume signals

Threshold: defines the point where the normal volume signal is located.

Energy Level Detection:  You may want to leave very sudden, short term 
changes in volume unchanged.  For example, you may not want to reduce the 
volume of a sudden bang, even if it is in a quiet section. If that is the case, 
enable this function. 

You have 3 time settings: Time Constant (overall duration of the sudden 
change), Attack Time Constant (the time the change takes to reach its peak), 
Decay Time Constant (the time the change takes to return to a normal volume).
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Plugins
Software Plugins Overview
The Plugins are 8-bit software based video processing tools. These tools can 
be used during transcoding or during ingest from a live source (as long as your 
system has enough CPU resources to keep up with the combined 
requirements of the live ingest and of the software plugins you have selected). 
Plugins are assigned to a specific codec profile. That is, each codec profile in 
your project can be assigned its own set of plugins, independent of any other 
codec profiles present in your project. After you have added at least one codec 
profile to your project the Plugins tab will be available.

The standard plugins included with Stream LE are:

• Cropping
• Deinterlace
The additional standard plugins included with Stream FE are:

• 601/709 Color Space Conversion
• Audio Channel Remapper/Selector
• Audio Down Mix 5.1 to Stereo
• Audio Level
• Audio Stereo to Mono
• Black and White
• Border
• Color Space Converter
• Field Dominance Converter
• Gamma
• Graphics Overlay
• Inverse Telecine
• Rotate Image
• Scaler
• Timecode Overlay
• Video Overlay
• Video Proc Amp
You can also use the “Add DirectX FIlters button to add DirectShow and DMO 
third party plugins to the list.
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There are also optional plugins (which can be purchased separately): 

• Civolution NexGaurd Watermarking (forensic watermarking)
• Civolution Teletrax Watermarking (video tracking)
• Google Fingerprinting (video identification)

Keyframing and Previewing Plugins
The Graphics Overlay, Video Overlay and Watermarking plugins can be 
keyframed, that is, they can change over time by creating points in time 
(keyframes) where the settings for that plugin will change. If you enable the 
“interpolate” option then the settings will change gradually over time from one 
keyframe setting to the next. For example, if you want a graphic overlay to fade 
up over 30 frames, then you would set a first keyframe where the mixer setting 
is at 0 (completely transparent) and you would set a second keyframe at 30 
frames where the mixer setting is at 1 (completely opaque) and you would 
check the interpolate option. The plugin will then calculate the mixer setting 
needed from the first frame to the 30th frame in order to fade up the graphic 
overlay gradually. If you do not enable the “interpolate” option, then the 
settings will remain the same without changing until the next keyframe is 
reached, and then the settings will change immediately to the new settings.

All plugins use at least one keyframe, the first keyfarme, which includes the 
initial settings. If you do not want the settings to change over time, you do not 
have to add any more keyframes. After you add a plugin (using the blue + 
button at the bottom of the Plugin list) and change at least one setting for that 
plugin, the Apply button will become active. This is the button that applies the 
current settings to the current keyframe. If you make changes to the settings 
and do not click the Apply button and you move to another keyframe, any 
changes you made to the settings will be lost. This includes the interpolate 
option. If you decide to enable the interpolation option for a keyframe, you must 
click the Apply button in order to save the new interpolate setting for that 
keyframe.

The Max Keyframe box at the top of the plugins tab indicates the maximum 
range of the keyframe slider. Note that this does not have to be the entire 
length of your clip. The final keyframe will be applied for the entire duration of 
you clip. For example, if you choose a Cropping plugin and apply one keyframe 
at the beginning of the keyframe slider, that keyframe will be used for the entire 
clip, no matter what the clip’s duration may be.

Next to the Max Keyframe box you will see a Frame Rate drop down box. Enter 
in the fps that is used by your video input or video clips.

If you apply more than one keyframe then you will see a red mark on the 
keyframe bar for each keyframe and a green mark on each bar for the 
keyframe you are currently on. To move between keyframes use the “>” button 
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to go to the next keyframe and the “<“ button to go to the previous keyframe. 
As you drag the slider on the keyframe slider you will see a blue mark on the 
keyframe bar that indicates your current position.

To preview the effect once you have added a plugin, you must choose one of 
the input patterns. You can choose between a preset graphic at common sizes, 
the same preset graphic at any custom size you specify, or a custom image (at 
the full image size). Once you have added a keyframe you may click the 
Preview button at the bottom of the Plugin list (near the lower left hand corner 
of the interface). Once you have previews the keyframes, scrubbing between 
the keyframes with the keyframe slider will show you what the effect will look 
like between keyframes.

Copying Plugins
If you have more than one codec profile in your project, you may copy a plugin 
along with all of its current settings from one codec profile to another. Select 
the codec profile that has the Plugin you want to copy. Then click the plugin 
you want to copy (in the plugin list), and drag and drop it onto the codec profile 
you want to copy the plugin to. 

Once you have copied a plugin, it is completely independent from the original 
plugin. That is, changing the settings on one copy of the plugin will not change 
the settings on the other copy.

Plugin Order
Plugins will be applied in the order that they are shown in the plugin list. For 
example, if you apply a Graphic Overlay plugin, and then a Scaling plugin, the 
graphic that you applied with the Graphic Overlay plugin will be scaled by the 
Scaling plugin. If you want to change the order of the plugins, you can use the 
blue up and down arrow buttons to move them to an earlier or later position in 
the list.

Plugin Settings

601/709 Color Space Conversion Plugin Settings
This plugin allows you to convert to/from the SD 601 color space from/to the 
HD 709 color space.
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Black and White Plugin Settings
This plugin removes the chroma from the video, converting the output to a 
gray-scale output.

Border Plugin Settings
The Border plugin adds a black border to the image. This plugin increases the 
size of the frame by the number of pixels you set for top, left, bottom and right. 

Color Space Converter Plugin Settings
The Color Space Converter plugin converts between different RGB and YUV 
color spaces. You may want to convert the color space if, for example, your 
source file was encoded using one color space, but the codec you are 
encoding to requires another color space. For example, QuickTime codecs 
often use an RGB color space, Real Video and Helix files use an I420 color 
space, and uncompressed AVI files typically use a YUV color space.

Color space options: I420, YUY2, UYVY, RGB24, RGB32, DRCYUY2 10-bit, 
DRC UYVY 10-bit, DRC YUY2 16-bit, DRC YUV Planar.

Cropping Plugin Settings
The Cropping Plugin removes pixels from the edge of the image. This plugin 
decreases the size of the frame by the number of pixels you set for top, left, 
bottom and right. 

Deinterlace Plugin Settings
This plugin deinterlaces the video based on the method you choose. If you 
choose Auto, the plugin will attempt to determine if the source is interlaced. If 
the plugin determines that the source is deinterlaced then the Motion Adaptive 
(Field Interpolate) method will be used. If it determines that the source is not 
interlaced then it will not use the plugin.

If you are capturing from a Live Source or Deck Control you will get better 
deinterlacing results if you use the hardware deinterlacing. Do not enable both 
hardware deinterlacing and this software plugin.
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Field Dominance Converter Plugin Settings
The Field Dominance Converter plugin allows you to switch the field order. 
There are two settings:

Top field to bottom field (shift picture up one line): All picture lines are shifted 
up one line and a black line is added at the bottom. Note that the original top 
line is deleted permanently.

Bottom field to top field (shift picture down one line): All picture lines are shifted 
down one line and a black line is added at the top. Note that the original bottom 
line is deleted permanently.

Gamma Plugin Settings
The gamma plugin can be used to boost the brightness on a curve (rather than 
as a linear function as with simple brightness and contrast controls). You may 
find the gamma controls useful when you are adjusting the levels of a video 
signal that you want to make into a digital file that will play back on a computer 
VGA monitor. Typically gamma values around 1.8 will give good results when 
adjusting video for display on a computer monitor.

Note that if you are capturing from a Live Source or Deck Control the hardware 
gamma controls will also be available to you.

Graphics Overlay Plugin Settings
The Graphics Overlay plugin allows you to overlay a still image over your 
video.If you use a file without an alpha channel or transparency layer, the 
graphic will be treated as one solid block. If you use a PhotoShop psd file with 
transparency, then the transparency in the psd file will be used to determine 
the transparency for the graphic overlay (NOT the alpha channel in the file, 
even if it is a 32-bit psd file with an alpha channel). However, if you save a 
PhotoShop file with an alpha channel as a 32-bit bmp file, and use the resulting 
32-bit bmp file as a graphic overlay, then it will use the alpha channel to 
determine the transparency for the graphic overlay. Some overlay samples can 
be found in the Overlays folder in your Stream directory.

Load the graphic you want to use by using the browse button at the end of the 
Filename field. 

The Mixer slider controls the transparency of the graphic, where 0 is 
completely transparent and 1 is completely opaque.
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The Position X and Y control the position of the upper left hand corner of the 
graphic. Position 0, 0 puts the top left hand corner at the top left hand corner 
of the image. Position 0.5, 0.5 puts the top left hand corner at the middle of the 
image. Position 1, 1 puts the top left hand corner at the bottom right of the 
image (off screen). You can also use negative values to position the graphic.

The Scale X and Scale Y settings control the size of the graphic, where 1, 1 is 
full size, 0.5, 0.5 is half size, etc.

Inverse Telecine Plugin Settings
This plugin is used to take NTSC 29.97 fps material that originated from film, 
went through a telecine process to convert the 24 fps film material to 29.97 
NTSC material, and now needs to be returned to the original 24 fps material.

Note:  DO NOT use the hardware deinterlace option at the same time as you 
use this plugin.

This plugin can handle media from film source with a regular 3232 telecine 
pattern (A, A, A, B, B, C, C, C, D, D), whether it is clean, unbroken cadence or 
broken cadence. It can also handle 2332 cadence detection, and mixed film 
and video source types.

Frame Rate: Set this to the desired output frame rate.

Source Type: Unknown, Film, Video (default Unknown)

The Source Type parameter is intended as a hint to the plugin, to indicate the 
original type of the source media. 

UNKNOWN is the default value, and should be used in all cases when the 
source is either unknown or known to be of mixed types (e.g. film and video). 
When you use this source type the output frame rate will be changed from the 
video frame rate to film frame rate (23.976 / 24 fps).

FILM mode is used when you know that all of the content is from film.  
Tip: for Film mode, leave the Look Ahead value set to 10 for your first attempt. 
When you use this source type the output frame rate will be changed from the 
video frame rate to film frame rate (23.976 / 24 fps).

VIDEO mode is used when you know that all of the content is from video, and 
you want to use the plugin to perform deinterlacing of the video footage. When 
you use this source type the output frame rate will maintain the video input 
frame rate (29.97 / 30 fps).

Look Ahead: 10 - 50 (default 10)

This value sets how many frames will be examined when attempting to 
determine the telecine pattern. Setting the Look Ahead value higher than the 
default of 10, causes the plugin to look at more fields when trying to determine 
the telecine pattern. 
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Setting the value higher may work well if the pattern is weak in the first few 
frames of the footage and then becomes strong, for example, if there’s a fade 
up at the start of otherwise clean film source footage. 

However in the case of a very weak but consistent telecine pattern a higher 
Look Ahead value may actually “muddy the water”, since the plugin must 
calculate tolerances and luma variances across too many frames to be feasible 
for the strength of the pattern. 

Setting the look ahead value too high may also cause performance issues. 
Lower values of the Look Ahead work better in most cases.

Fixed Cadence: False/True (default False)

Set this to True only if the source media is of unbroken telecine cadence. In 
this case the plugin will not try to detect new source mode types or cadence 
breaks once an initial cadence has been detected. 

This parameter will provide the best results in cases of unbroken cadence in 
which the telecine pattern may be weak in sections, but strong at the start.

When used with the A Frame setting below, it can also be used when the 
cadence is weak at the start, but the start frame for the telecine pattern is 
known.

A Frame: 0 - 50 (default 0)

This parameter can be used in conjunction with Fixed Cadence = True to 
specify the frame number of the first frame in the Telecine pattern. 

If set to a value of zero, the plugin will attempt to determine the first valid A 
frame, and then will assume the pattern is unbroken from that point forward.

If set to a value greater than zero the plugin will use this frame number as the 
first A frame and perform the inverse telecine regardless of the actual telecine 
cadence of the media.

Interpolate Fields: False/True (default False)

If set to True when the Source Type = UNKNOWN , then the plugin will 
interpret sections of the media where a cadence pattern cannot be determined 
to be from a video source, and will remove interlacing in those sections.

If set to True when the Source Type = Video, then the plugin will always 
remove the interlacing in the media.

This deinterlacing may introduce a general softening effect in the output.

Field Motion Threshold: 0 - 1.0 (default 0.5)

This parameter can be used in conjunction with Interpolate Fields = TRUE, and 
is valid only when Source Type = VIDEO and input frame rate = output frame 
rate.
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In that case, this setting is used to tweak the interfield motion detection 
algorithm, that determines when to interpolate fields (based on the amount of 
inter field motion). The default value of 0.5 is best for most clean video, but 
experimentation may yield better results for some footage.

Rotate Image Plugin Settings
This plugin allows you to rotate the video image by +90 degrees or -90 
degrees. It is most commonly used when preparing video for display on a 
mobile phone or other mobile device.

Scaler Plugin Settings
The Scaler Plugin allows you to change the width and height of the video image 
in pixels. You can also adjust the vertical and horizontal filter. Negative values 
for the filter setting will make the edges softer, and positive values will make 
the edges sharper.

Timecode Overlay Plugin Settings
This plugin allows you to overlay timecode on the video. There are three 
timecode modes:

• Timecode from Live Source: The timecode is read from the live source (as 
set on the Input tab).

• Render Timecode: The timecode is rendered in hh:mm:ss:ff using the start 
time you specify (in frames). This can be used when transcoding or 
capturing from a live source. The frame rate used is the frame rate of the 
source.

• Date and Time: The system date and time are used.
Note that for real-time timecode overlay you must use a font size of 320 or less. 
For NTSC timecode burn-in, to place the timecode centered in the lower part 
of the image, a Horizontal offset of 220, Vertical offset of 380, and font size of 
60 would be typical.

Video Overlay Plugin Settings
The Video Overlay plugin allows you to set a video file to use as an overlay and 
a graphic still image file to use as an alpha channel mask for the video overlay. 
The graphic still image file you use can be a 32-bit bmp file with an alpha 
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channel or a Photoshop file with transparency. The alpha channel of the bmp 
file or transparency of the psd file will be used as the alpha channel for the 
video overlay.

The mixer can be used to determine the transparency of the opaque areas of 
the video overlay.

Video Proc Amp Plugin Settings
This plugin allows you to adjust the settings typically associated with video 
proc amp settings, namely Brightness, Contrast, Blue Gain, Red Gain, Blue 
Offset, Red Offset and Hue.

Note that these are the same as the Hardware video proc amp settings, so if 
you are capturing video using a DRC board, you can use the hardware Video 
Processing settings instead of the software plugin.

Civolution NexGaurd Forensic Watermarking
This optional plugin allows you to add an invisible forensic watermark to your 
video image. As well as embedding the watermark the plugin produces the log 
files that is required by the NexGaurd database.

Civolution Teletrax Watermarking
The Teletrax plugin is used to embed watermarks for content tracking and 
monitoring. As well as embedding the watermark the plugin produces the three 
log files that are required by the Teletrax database for the tracking and 
monitoring functions.

Google Fingerprinting 
The Google Fingerprinting plugin is used to create an xml file at the time of the 
encode that can be uploaded to YouTube and used to find any footage that 
matches the xml fingerprint file.
 



Digital Rapids Stream Software
Video Process (Hardware based)
The controls on the Video Process tab are hardware-based processors that 
can be used to alter the video input signal when you are using Live Source or 
Deck Control as an input type. Because they alter the video input, they are 
“global” settings, meaning that the changes made on the Video Process tab will 
be used by all codec profiles in the project. The video process controls include 
Cropping, Processing Amplifier (Proc-amp), Horizontal/Vertical filtering, Noise 
reduction control and Graphic Overlay controls. 

Video Process controls cannot be used when you are transcoding a file. When 
you are transcoding a file you must use the Plugins to alter the video image. 

Cropping
The hardware Cropping controls affect how much video is removed from the 
top, bottom, and sides of the incoming video.  Typically you would use cropping 
to remove the black areas which often surround a video image (known as 
‘underscan’), or the large black bars above and below the image found in 
letterboxed material. 

Keep in mind that when you remove lines from the video, you are not changing 
the size that will be used by the codec profile. This means that if you crop 20 
lines from the height of your video, the picture will be “stretched” to fit the size 
of your codec profile. If you don’t want this to happen, you must also reduce 
the vertical height of your codec profile by 20 lines.

Deinterlacing
Each frame of video from an NTSC or PAL source will contain 2 interlaced 
fields. Video that is displayed on a computer VGA monitor will be displayed 
frame by frame. In order to display the video correctly on a computer VGA 
monitor, it must be deinterlaced.

Deinterlacing for the HD Boards (DRC-5500): Deinterlacing is set in 
your Source Profile (on the Input tab).

Deinterlacing for the SD Boards: An Enable Deinterlacing box will be 
found on the Video Process tab. Check the Enable Deinterlacing to use the 
Stream hardware’s deinterlacing feature. If you plan to deinterlace the video 
the hardware deinterlacing will give you superior quality compared to a codec’s 
software deinterlacing. (Do not use both the hardware deinterlacing and the 
codec’s software deinterlacing.)

Note that Temporal Noise Reduction (3D noise reduction) can only be used if 
hardware deinterlacing is enabled.
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Processing Amplifier (Proc-Amp)
The Processing Amplifier  (Proc-Amp) controls affect the brightness, contrast, 
saturation, and hue (hue for SD boards in NTSC mode only). You can also set 
individual color gain and color balance. 

The gamma controls can be used to boost the brightness on a curve (rather 
than as a linear function as you do with the simple brightness and contrast 
controls). You may find the gamma controls useful when you are adjusting the 
levels of a video signal that you want to make into a digital file that will play 
back on a computer VGA monitor. Typically gamma values around 1.8 will give 
good results when adjusting video for display on a computer monitor.

Filtering and Noise Reduction
When you filter a video signal you are reducing the high frequency part of the 
video signal. In ideal situations, high frequency signals are created in response 
to details in the image, such a fine lines. In practice, high frequency signals are 
often noise, so filtering out some of the high frequency signal is a good idea.

The Horizontal and Vertical filtering controls allow you to override the default 
filtering values used by the Stream drivers. For example, you may want to turn 
up the filtering (over-soften) because the video contains noise from the camera 
it was shot with, or you may choose to under filter a very clean video source in 
order to bring out additional detail.  

Adding more filtering (over-filtering) will make it easier for the codec to 
compress the video stream at the expense of some of the detail in the image.

You will also be able to apply Temporal or motion adaptive 3D noise reduction. 
Temporal noise reduction works best with low level noise such as tape noise 
or noise caused by low lighting levels. 

When you are adjusting the noise reduction you can temporarily disable it by 
clicking and holding down the disable button at the end of the drop down box. 
This allows you to compare the video source and the video with the noise 
reduction applied, so that you can check the effect.

Temporal Noise Reduction
Temporal noise reduction compares images in sequence over a 
predetermined period of time, blending the images between fields or frames. 
The simplified theory is that by blending data over time you can reduce the 
overall noise content of the resulting image. This is used in the film industry to 
remove film grain from blue or green screen shots. Successive samples of the 
same blue or green screen scene are blended together which will effectively 
cancel out the noise found in any individual frame. The problem with typical 
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noise reduction algorithms is that if there is any motion in the individual scene 
you will get a motion blur (trails) artifact in the processed frame. One answer 
to this is to limit the blending process to a specific range of frames or to restart 
the process every few frames. This is very visible in the noise reduction found 
in some software codecs. Every few frames the noise reduction will reset and 
the noise will suddenly reappear only to disappear several frames later, then 
the process starts over again. 

The DRC-Stream hardware uses a very advanced form of temporal noise 
processing called motion adaptive 3D noise reduction. Motion adaptive 3D 
noise reduction combines the information in multiple frames of video using the 
information obtained from the motion adaptive de-interlacing in order to decide 
how much processing is applied to each pixel in the final frame. Because each 
pixel is calculated individually the result will be more precise noise reduction 
with less motion blurring artifacts than would otherwise be normally possible. 
Note that Temporal Noise Reduction can only be used if deinterlacing is 
enabled.

There are three possible settings for the 3D motion adaptive noise reduction:

None: No noise reduction is applied

Optimal: A predetermined amount of noise reduction is applied.

Custom:  You are free to set the amount of noise reduction applied.  Too 
much noise reduction will result in motion trails effect.

If you choose the Custom option, you will be presented with the Temporal 
Noise Reduction window.  You can set the amount of noise reduction applied 
and preview the output in real-time.  Selecting OK saves the current setting.

Spatial Noise Reduction
If you have an SD board (DRC-500 to DRC-2500) you will also be able to apply 
Spatial or 2D noise reduction. Spatial noise reduction works best with single 
pixel ‘salt and pepper’ type noise such as video dropouts. Spatial and 
Temporal noise reduction can be used separately or together. 

Spatial or 2D noise reduction only affects the current frame of video, 
specifically targeting high frequency noise which is not part of the structure of 
the image.  It specifically attempts to deal with high frequency noise which is 
not part of the edge of an object in the picture or other structures in the video.

There are three settings for 2D noise reduction:

None: No noise reduction is applied

Optimal:  A predetermined amount of noise reduction is applied. This has 
been determined by testing with many hours of video.

Extreme:  A greater amount of noise reduction is applied at some loss of 
overall picture sharpness.
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Graphics Overlay
When you are using a Live Source or capturing using Deck Control you can 
use a hardware graphic overlay, as a title board, watermark or a logo for 
example. A 32 or 24 bit graphic can be used.

A 32 bit bmp sample and a Photoshop psd file that shows how this bmp file was 
created is located in the Overlays folder in your Stream directory. Note that the 
32-bit bmp file does use the alpha channel in the file to determine the 
transparency for the graphic overlay. However, if you use a Photoshop file the 
transparency in the file will be used to determine the transparency for the 
graphic overlay and NOT the alpha channel in the Photoshop file.

To use this function, click the Graphic Overlay Settings button. Use the 
checkbox at the top of the Settings window to enable this function. Browse for 
a file to use as your overlay. 

Set a default fade duration. 

Set the position and scale your graphic if desired. 

Click OK to save your settings and close the window. 

Click the up arrow to fade up the graphic using your fade duration and the down 
arrow to fade down the graphic using your fade duration. Click the slider button 
to open a slider that will allow you to manually fade up and down the overlay.

Output
The output tab controls where the final encoded video will be stored, 
broadcasted, published or delivered.  The output tab is context sensitive to the 
codec profile currently selected in the codec profiles list. Each codec profile will 
have its own output options. 

Monitoring Video and Audio during encoding
While you are encoding you will be able to monitor your video and audio.

If your CPU usage is high during a live encode you will be able to reduce it 
slightly by toggling the Monitor Source button off.
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While you are encoding, the audio preview that you hear will be the audio from 
the source. The video you are seeing will be the video from the encoder. The 
audio preview from the source will not be in sync with the video from the 
encoder. However, the encoded audio will be in sync with the encoded video, 
so the final encoded file or stream will be in sync.

While you are encoding, you may mute the audio preview by clicking the 
“toggle audio mute” button found above the VU meters. This will not mute the 
audio in the encoded file. 

While you are encoding all of the Video Process and Audio Process controls 
will be available to you. For example, while you are encoding you can adjust 
the volume of the audio. This will affect the volume of the audio in the encoded 
file or stream.

Archive 
An archive file is a file saved to a hard drive. 

For HD Boards: For HD output in real time you must direct the output file to 
the RAID.  Do not use the default OutputMedia folder found on your C drive.  
That drive will not be able to keep up with HD data rates.

Tags: You may want to use “tags” in your archive file name, to automatically 
insert information such as the date and time into the file name.  (See “System 
Tags” on page 69 for more information on Tags.)

Progressive Download: For AVC MP4 files, this option will perform a post 
encode step that will move the file’s “index” from the end of the file to the 
beginning of the file. After this step, when the file is downloaded from a web 
server the viewer will be able to start playing the file before the download is 
complete. 

Rollover Mode: For Windows Media and Real Helix you will be able to encode 
to a single file (default) or to automatically start a new file based on the 
encoded file size or duration. The root file name will automatically be appended 
by an incrementing number, so that a new file will not over-write an existing file. 
Note that if you use system tags in your file name the tags will only be 
calculated at the end of the first file, so for example, if you used a time tag it 
would only be the time of the first file.

Use Custom Block Size: When you are encoding an MPEG file you will be 
able to set a custom block size.

Helix 10 DRM: When you are using Helix 10 you will see an “Enable DRM” 
option. In order to use DRM you must obtain a license from RealNetworks. You 
must also obtain a special build of the DRM software from RealNetworks, that 
has been customized to work with Digital Rapids boards.
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Broadcast 
Use this option when you want to stream a live source to a video server and 
broadcast to the internet or an intranet. The following codecs can be used for 
live streaming:

• Ateme (used in the Group Codec)
• Dicas (H.263/MPEG 4/H.264 plus AMR or AAC audio, RTP/RTSP)
• Digital Rapids AVC for Web
• Digital Rapids Streaming for iPhone
• Digital Rapids Studio AVC Encoder (used in the Group Codec)
• Adobe Flash 8 On2 VP6
• MainConcept MPEG2 Transport Stream
• Microsoft VC-1 (used in the Group Codec for ASF and Smooth Streaming)
• Microsoft Windows Media
• Real Helix
Please refer to the documentation for a specific codec for more information 
about setting up that codec for live streaming. Documents can be found in 
C:\Program Files\Digital Rapids\Stream\Documents.

If you are using the Group Codec, the following processors can be used for live 
streaming:

• ASF Muxer (for VC-1)
• Manzanita TS Muxer (UPP/RTP)
• Native RTP (for RTP/RTSP and Flash RTMP)
• Smooth Streaming Container (for delivery to an IIS Server)
Each processor has settings that are specific to the media server or player 
intended to play back the live stream.

Output of a Native RTP broadcast stream can be decoded and played by a 
software player (such as the QuickTime player) or by some Set Top Boxes. 
Alternately the output can be sent to a media server that handles RTP packets, 
such as the Darwin Media Server. For basic information about setting up a 
Darwin Media Server on a Windows OS, please see 
Darwin_Streaming_Server_Setup.pdf, which is located in C:\Program 
Files\Digital Rapids\Stream\documents.
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Windows Media DRM
When you have a Windows Media codec in your Codec Profiles list, and you 
have selected that codec, you will see a WM9 DRM button. This function 
allows you to connect to one of the currently supported DRM license providers 
and to exchange key information, so that the encoded media has been 
encrypted with the appropriate key.

Note that Stream does not support the use of .drm files.

In order to use this function you must have an agreement in place with the 
Windows Media DRM license provider that you have selected. 

Alternatively, you may generate key values yourself and make your own xml 
files that can be called by the “Basic DRM Key Retrieval” option. These xml 
files can be retrieved from a URL (using http and port 80, or https and port 443) 
or from a file on your LAN. A sample xml file that can be used for this purpose, 
Basic_WMDRM_Response.xml, can be found in C:\Program Files\Digital 
Rapids\Stream\documents.

PlayReady DRM
When your output is a Smooth Streaming file or live broadcast one of your 
output options will be PlayReady DRM. This is a digital rights management 
technology from Microsoft. When you encode your media it is encrypted using 
a set of keys. A PlayReady license acquisition URL that identifies where to 
make a request for a valid license for a piece of content is included in the 
header of the encoded media. When the media is played back the player 
attempts to acquire the license needed to decrypt the file for playback, or to 
redirect the viewer to a web site where they can acquire the license.

For more information on PlayReady in Digital Rapids Stream please see 
PlayReady_DRM.pdf, which can be found in C:\Program Files\Digital 
Rapids\Stream\documents.

Command (Stream FE) 
This option allows you to enter in a command line function that will start an 
external application once encoding/transcoding has stopped. Any application 
that can be called from a command shell can be run at the end of an encode 
using this feature by typing the path and filename of the external command into 
this box.
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Example 1:
Call a batch file which copies the finished encoded file from the C drive to the 
E drive and then deletes the original. 

Create a batch file called c:\utils\move.bat 

Add this to the Command box (including the entire path and file name)

Call the Archive file C:\output\news.wmv

Contents of the move.bat file:

copy E:\output\news.wmv D:\final 
del E:\output\news.wmv 

You can use wildcards in your batch file, so alternatively you could use: 

copy E:\output\news* D:\final 
del E:\output\news* 

Example 2:
Move a Stream archive output file that uses a Stream system tag (a time 
stamp) from the default OutputMedia directory to another folder (either a local 
folder or a network folder)

For the Archive file name enter Clip_%T_%.  The %T_% is a Stream system 
tag which will be replaced with the time that the file was encoded.  For 
example, if the file was a Windows Media file encoded at 4:18 PM the name 
would be Clip_4_03_18 PM.wmv (where the time is HH_MM_SS AM/PM).  
Note you could also use %D_% to append the date to the file as well, e.g., 
Clip_%D_%_%T_% would append both the date and time to the file name.

For the Command function in Stream, enable the function, click the Command 
button and enter:  C:\Temp\Test\move.bat "%PROF.ARCHIVE.FILENAME%"

Note that the "%PROF.ARCHIVE.FILENAME%" is the tag that gives the entire 
path and filename for the archive file just created.

In the move.bat file referenced above, the contents of the bat file:  

move %1 D:\Temp\Test\

This moves the file to the D:\Temp\Test\ directory.  You can edit the bat file in 
Notepad and change this to any drive or folder, either local or on your network.

Note the %1 in the bat file will be replaced by the archive file name, using the 
tag in the Command function.
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Project Command Function (Stream FE)
This function is very similar to the Command function, except instead of 
operating on a codec-by-codec basis, it operates after encoding has finished 
for all codec profiles.

To access the Project Command Function highlight the Codec Profiles heading 
and then choose the Output tab.

Publish 
This feature allows you to use a Publish Template file which includes tags. The 
Publish Output file will be your template with your tags replaced by the 
information from the encode. For example, you could create an encoding 
report which shows the details of the encoding session, or an html web page 
which includes an embedded player with a tag for your archived video file. 
There are some sample template files installed for you in your 
Stream\PublishTemplates folder.

To access the Publish command on a codec-by-codec basis, select the codec 
you want to publish data for, and enable the Publish button. Be sure to use 
Codec Profile-Level tags for your published output. 

To access the Publish command for the entire project (a Stream FE feature), 
select the Codec Profiles heading and then choose the Output tab. Be sure to 
use Project-Level tags for your published output.

A list of all tags can be viewed by choosing Help > System Tags.

MPEG Muxer (MainConcept)
The MainConcept MPEG Muxer can be used to do a post-encode muxing step 
on the MPEG2 video elementary streams and audio streams you just created 
during the encoding step. This allows you to perform custom muxing that is not 
supported by the standard MainConcept MPEG codec profile, such as muxing 
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AC-3 audio files, or multiple audio files all with their own language codes. As 
an example, please see the sample VOD projects included with Stream that 
have the MPEG Muxer set up for a CableLabs encode.

Note that there is also a MainConcept Muxer Tool available (found in Tools > 
MPEG2 > Muxer) which can be used to mux together previously encoded 
MPEG2 video elementary streams and audio streams.

You can find more information about muxing settings by opening the 
Stream\Documents\MPEG_Encoding_Guide.pdf file and then looking in the 
Advanced Multiplexing section.

DVD (Stream FE)
DVD output can be used to save your files as DVD ready folders and files with 
an automatically created simple menu structure. When the DVD output is used 
with Deck Control and a capture log you can create a DVD with a menu and 
chapter points. If you use the DVD output with a single clip (either from a live 
source, a single clip in a capture log, or a single transcoded media file) then 
your DVD output will not have a menu or any chapters.

If you are using Deck Control to capture your clips and make a DVD with a 
menu and chapters, then Concatenate Output must be enabled. You must also 
enable the “Force I-frame at inpoints” in the MPEG codec profile. The in-points 
on the capture log will be used as chapter points for your DVD.

Note that you will only see this option when you are using an MPEG2 codec 
profile that was created with the Codec Profile > Create > MPEG2 - 
MainConcept > DVD option.

When you click the DVD button the following window will open:
 



Digital Rapids Stream Software
You can use it to change the text that is shown as the title of the DVD, choose 
between a 4x4 or 3x3 chapters per menu, and choose a background image (a 
jpg, gif or png file). You must also set a Output folder (for your Video_TS and 
Audio_TS folders) and a Temporary items folder that will be used while 
creating the DVD folders.

The Chapter names text is based on tags (a list of valid tags is shown when 
you hover your mouse over the text box, and is shown below).

You can change the text color and the text outline color (or disable the outline 
by disabling the check box. The highlight color is the color that will be shown 
when you are on a chapter selection.

If you are using anamorphic footage you can enable the Anamorphic check 
box.

You can switch between the Preview and Contents tab to see the effect of your 
changes on your DVD menu.

Omneon File (MPEG2 Wrapped in MOV)
If you have purchased the Omneon MOV Output option one of the MPEG 
output options will be Omneon File. This post-encode step wraps the MPEG2 
archive file plus AIFF or PCM/WAV audio files in an MOV file.

To set up the project, add an MPEG2 video elementary stream codec profile 
(video only, multiplexing type set to None). If you are encoding NTSC add a 
Field Dominance Converter plugin, as the Omneon server only supports top 
field first video. Add AIFF or PCM/WAV audio codec profiles. Set an Archive 
file name for each of the elementary stream files. Select the MPEG codec 
profile and enable the Omneon File output, then click the Omneon File button.
 55 

 
• 
• 
•
•
•



56 

 
• 
• 
•
•
•

Digital Rapids Stream Software
On the Omnenon File window the Video file is the archive filename of the video 
codec profile. Also the Audio elementary streams are filled in with any AIFF or 
WAV file archive names that are in the project. If you do not want to use one 
of the audio outputs in the Omneon output, then disable its checkbox.

If you are creating a reference file then you must use the specific output 
directory structure expected by the Omneon server. On the root of one of your 
drives create a new folder called clip.dir, and a new subfolder called media.dir. 
Any drive may be used, but you must use the root of the drive, not a sub-folder. 
When encoding video and audio files you must save the archive output files to 
clip.dir\media.dir. You must save the Omneon output file to clip.dir. The same 
drive must be used for video, audio, and reference file output.
 



Digital Rapids Stream Software
FTP (Stream FE)
Send your archived file using ftp. To enter an item, click the FTP button, and 
then click the Add button. This will open an FTP Item window. Enter in the 
information for that item.

It will often make sense to use Stream system tags to represent the destination 
file name (%OF%.%OE%) and source file (%PROF.ARCHIVE.FILENAME%, 
which will provide the full path and file extension of the archive file).

When you click OK the item will be added to your FTP list.

You can then add another item to the same folder by clicking the destination 
folder name and then clicking the Add button.

If you want to send some items to a different FTP site, you can click the Add 
button and create a new FTP Item with the new server information.

If you need to edit the information, you will edit the level that you have 
highlighted. For example, if you need to change information about the server, 
but not information about the folder or files, highlight the server information 
before you click the Edit button.
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E-mail (Stream FE) 
Send an e-mail to tell someone that the encode is complete and/or to e-mail 
them a file.

Enter your SMTP mail server, the port used by the server, your e-mail address 
and your e-mail password. Enter the e-mail address of the person the email is 
from and the person the e-mail is to. 

Modify the Subject if desired, and enter a Content File to show in the body of 
your e-mail message. This can be a simple text file, or it could be a text output 
from the Stream Publish command, with information automatically filled in. 
(There is a sample Email.txt file in the Stream\PublishTemplates folder which 
you can use as a sample for the Publish Template. Set your Publish Output file 
and enter that as the Content File in the Email window.)

You may also add attachments to your e-mail. The attachments could include 
the video file you just encoded, or other supporting files. If you want to attach 
the video file the recommended tag to use would be 
%PROF.ARCHIVE.FILENAME%. This tag is used to provide the full output 
archive filename, including the path and file extension. 

Encrypt (Stream FE)
You can use this function to encrypt an archive file after the encode has 
finished using 192-bit AES encryption.
 



Digital Rapids Stream Software
The first time you use this function you will need to create a license file.  This 
is the file that will be also be used to decrypt the file.  Enable the Encrypt 
function and click the Encrypt button. 

Click the “Create a new package encryption license file” button.  Type in a file 
name and click the Save button. You will then be asked to enter a password.  
This password is used to create the license file, not used decrypt the file.  
Should you ever need to recreate the license file you will need to enter in the 
same password. You will be asked to confirm your password, and then the 
license file will be created.

If you already have a license file you would like to reuse, you can browse to 
this license file instead of creating a new one.

Enter the full path and full name of the file to be encrypted, or simply enter in a 
tag that includes the full path, i.e., %PROF.ARCHIVE.FILENAME%.

Enter an output file name including the file extension (e.g., avi, mpg, etc.).  If 
you do not include the file extension, the decrypted file will not have a file 
extension. If you do not give a path for the output file it will go into the main 
Stream directory by default.  If you would like it to go into the OutputMedia sub-
folder be sure to include that in the path name, or use the browse button to 
select the encrypted file location.

Optionally, you may choose to “delete the original file once the encrypted file 
has been created”.  That way the original, unencrypted file will not be 
accidentally left on the hard drive, and only the encrypted copy will be in the 
Output media folder.

To decrypt the file choose Tools > Launch Package Decryptor.  On the 
Package Decryptor window choose File > Package Decrypt.  This will open a 
window that will prompt you to select the file you want to decrypt.  Once you 
have selected an encrypted file, a second window will open that will prompt you 
to open the license file needed to decrypt the file.  This is the same license file 
that was used to encrypt the file. 
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Statistics
The Statistics tab displays real-time feedback during encoding. The display is 
context sensitive to the codec profile chosen in the codec profile list.  Some 
codecs provide statistics during encoding and some do not.  For example, you 
will see statistics when using Windows Media and Real Helix, but not during 
MPEG encoding.

Note that during encoding you will see the CPU usage and Buffer usage go up.  
Should the CPU usage exceed 100% the buffer will start to fill.  When the CPU 
usage drops under 100% the buffer usage should drop back down.  Should the 
buffer usage also reach 100% you will start to see the Dropped Frames 
counter go up.

If the CPU usage does not reach 100% but you still see the Buffer usage go 
up, your drives may not be able to keep up with the output data.  If you have 
an HD board, make sure you are directing HD file outputs to the RAID and not 
to the C drive.

You may also see your CPU usage stay low, but your buffer usage go up, if 
you are encoding on a multi-core CPU system, but using a codec that cannot 
take advantage of all of the cores. For example, if you are encoding using the 
Flash 8 On2 codec, which can only use one core, and you are using a system 
with 4 CPU cores, a CPU usage of only 25% is the maximum that can be used 
by that codec before it starts to fill the buffer.

Starting and Stopping Encoding
Start/Pause/Resume/Stop
You can start and stop encoding using the buttons found in the lower right hand 
side of the interface. 

For live encoding, after you have clicked the Start button it will change to a 
Pause button. If you click the Pause button, it will change to a Resume button. 
If you click the Resume button it will continue recording to the same file.

Triggers
You may use triggers to start and stop encoding. To select which trigger you 
want to use click the Trigger button found directly above the Start button. You 
may start encoding based on a GPI trigger, a keystroke or LTC (when using 
 



Digital Rapids Stream Software
Stream FE with a DRC-500 to DRC-5650 board). You may stop encoding 
based on a GPI trigger, duration or a keystroke, or LTC (when using the DRC-
5650 board).

For LTC trigger on the DRC-500 to 2600 you must use the left audio input for 
the LTC trigger. Once you press Start, the Stream app will start “listening” for 
the LTC you have entered as the trigger, and once it detects the timecode you 
set, it will start the encoder. Note that due to encoder startup delays, the 
encoder may take anywhere from one frame to a few frames to actually start 
writing the first frame, so the in-point of the file will be slightly later than the LTC 
you entered as the trigger.

For more information on setting up a GPI trigger and making GPI cables, 
please see “Using GPI Triggers” on page 83.
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Stream Software Feature Chart
• = standard feature 
o = optional feature

Features are subject to change without notice.

Input Formats (File-Based) Stream 
LE

Stream
FE

AVI • •

MPEG1 & 2 (including VOB), MPEG4/H.264 • •

QuickTime (Media and Reference files) • •

Microsoft Windows Media / SMPTE VC-1 • •

WAV (incl. RF64, Broadcast WAV) and MP3 • •

Avid DNxHD in MXF o o

MXF o o

Omneon (MOV reference files only); Note some  third party 
MPEG2 decoders may allow this to work with self-contained 
files also

• •

GXF o o

LXF o o

DV/DVCPro 25/50/100(HD) in AVI, MXF, GXF, LXF o o

DV/DVCPro 25 in MOV o o

Red Camera (R3D files) o

Image sequence input (SD, HD, Film) •

JPEG2000 in MXF o o

AES3 audio (SMPTE 331M and 302M, AES3-2003) wrapped in 
TS or MXF

• •
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+ CableLabs is a registered trademark of Cable Television Laboratories, Inc.

Output Formats (Video only or Video + Audio) Stream 
LE

Stream
FE

Adobe Flash 8 On2 o o

Ateme H.264/AVC elementary stream encoder o

Avid DNxHD o

Dicas 3GPP (H.263, H.264, MPEG-4 Part 2, AAC and AMR) o o

Digital Rapids AVC for Web (MP4, MOV, M4V, .FLV/F4V, 3GP) o o

Digital Rapids Streaming for iPhone o o

Digital Rapids Studio AVC (H.264 Elementary Streams) o

DirectShow AVI • •

DRC Video (uncompressed YUV plus timecode and cc) • •

DV/DVCPro 25/50/100(HD) (in AVI) o o

DV/DVCPro 25/50/100(HD) (in MXF, MOV) o

DV/DVCPro 25/50 (in LXF, GXF) o

Image Sequence (18 still image formats) •

JPEG2000 (image sequence or in MXF) o

Microsoft Smooth Streaming • •

Microsoft Windows Media (VC-1, WMV, Microsoft Silverlight) • •

Microsoft VC-1 (Elementary Streams, Closed Captions, etc) • •

MPEG MainConcept: MPEG-1 and MPEG-2 (4:2:0 and 4:2:2, 
compatible with CableLabs® VOD specifications) +

o •

MPEG-2 Broadcast (UDP/RTP with RTSP) o •

QuickTime 7 (AVC/H.264 and AAC, AMR for FE only) • •

RealVideo, RealAudio (Helix) 9 & 10 • •
 



Output Formats (Audio Only) Stream 
LE

Stream
FE

AES3 audio (SMPTE 331M, AES3-2003) (*included only when 
MXF writer is enabled)

*

AIFF • •

Dolby® Digital and Dolby® Digital Plus (stereo or surround, File 
ONLY or file + Live)

o o

Dolby Pulse (AAC-LC, AAC-HE, stereo or surround) o o

Nero AAC o o

Thomson MP3 audio (stereo and surround) o •

WAV audio (multi-channel, RF64, Broadcast WAV) • •

Output Formats (Processors used in the Group Codec) Stream 
LE

Stream
FE

ASF Muxer • •

Elementary Stream File • •

GXF Wrapper o

LXF Wrapper o

Manzanita TS Muxer o

MOV Muxer (*included with MPEG2, DVCPro, DR AVC, Ateme) *

MPEG-4 Muxer (*included with DR AVC or Ateme) *

MXF Wrapper o

Native RTP (*included with DR AVC or Ateme) *

Smooth Streaming Container • •
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* For DRC-1000 to DRC-5650 boards

Other Output Options Stream 
LE

Stream
FE

Closed Caption file support (SCC, SAMI, SRT, DFXP) • •

Group Codec • •

Omneon (MOV) Output and Tools > Omneon Wrapper o o

RTMP Streaming broadcast option (*included with the DR AVC 
for Web bundle, optional for use with DRC Studio AVC or 
Ateme)

*

Tools > H.264 > CC Embedder (*included with DR Studio AVC 
or Ateme)

*

Tools > MPEG2 > Muxer (*included with MPEG2 MainConcept) * *

Tools > MXF Wrapper (*included with MXF Wrapper option) *

General Functionality Stream 
LE

Stream
FE

Capture/encode from live video and audio inputs • •

Capture/encode to files from decks with RS-422 control o •

Transcode from source media files • •

Watch Folder for media file inputs •

Batch Encoding (real-time capture with auto transcode) •

Timecode (preserve, auto increment or time of day) • •

VBI capture (with Closed Caption support)* • •

CC 608 and 708 capture from SDI and HD SDI • •

Clip Lists (multiple input clips to multiple or concatenated output) •

Duration-based encoding • •
 



* For DRC-500 to DRC-2600 boards

* For DRC-500 to DRC-2600 boards

Audio Processing Controls Stream 
LE

Stream
FE

Multiple channel audio • •

Volume • •

Sample rate conversion • •

Hardware 7-Band Parametric EQ * • •

Hardware Dynamic Range Exp/Comp * • •

Hardware Bass/Treble * • •

Software audio processing plugins (all boards) •

Video Processing Controls Stream 
LE

Stream
FE

Hardware deinterlacing • •

Horizontal & Vertical Filtering • •

Spatial noise reduction (2D) * • •

Temporal noise reduction (3D) • •

Hardware Proc Amp controls • •

Gamma Correction • •

Hardware scaling, cropping, graphic overlay • •

Software video processing plugins: deinterlacing, cropping • •

Software video processing plugins (except watermarking) •

Software watermarking plugin: Civolution CompoTrack o

Software watermarking plugin: Civolution Teletrax o

Software watermarking plugin: Thomson NexGuard o
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* DRC-500 to DRC-2600 boards

Publishing and Advanced Output Stream 
LE

Stream
FE

CEA-608 and 708 Closed Captioning support • •

Template-based publishing interface • •

Log publishing – per codec • •

Log publishing – per project or persistent (all projects and 
codecs)

•

DVD publishing (menuless or chapter-based menu from deck 
capture points or clip list)

•

Direct DVD publishing to Rimage Producer III, Rimage Profes-
sional and Primera multi-disc production systems

•

E-mail notification •

Automated FTP distribution •

Media file encryption/decryption •

Support for third-party Windows Media DRM providers (Entriq, 
SyncCast, thePlatform, generic)

• •

Workflow and Application Integration Stream 
LE

Stream
FE

GPI and keystroke trigger • •

LTC timecode encode start trigger, stop trigger for DRC-5650 • •

Controllable via Digital Rapids Broadcast Manager o

Integration with Digital Rapids Transcode Manager • •

Web Services (SOAP) API o o

WDM (Windows Driver Model) drivers* • •
 



System Tags
Tags can be used to add automatically generated text strings into file names, 
reports, html pages, etc. 

System Tags are pre-programed tags that can use data that is available from 
the system at the end of an encode, such as the date, time, file name, CPU 
usage, number of dropped frames, etc.

Filename example:  C:\Output\%BN%-%R%-%T_%.wmv uses the tags for 
Project name (%BN%), resolution (%R%), and time (%T_%). The output file 
name would look like C:\Output\MyProject-320x240-4_10_51_PM.wmv

Encoding a second file without changing any settings within the Stream app 
would generate a unique filename encoded with the current time.  By using a 
combination tags you can create a default output filename which will 
automatically generate a unique filename.

There is a sample VideoEncodingReport.html in the Stream\PublishTemplates 
folder that uses system tags to generate a report.

There is a sample Player_WM_Template.html in the 
Stream\PublishTemplates folder that uses system tags to generate a web 
page that includes an embedded WM Player that will automatically link to the 
archived WMV file.

Note that in the table of system tags there are some that have a Description of 
“safe for use in file names”, or simply “safe”. These tags expand to values that 
don’t contain colons or slash characters, and are therefore safe to use in 
filenames.  For example, %T% expands to "12:34:56PM" but %T_% will 
expand to "12_34_56PM".

To open a full list of system tags from the Stream software use the main menu 
to select Help > System Tags.

The list can also be opened from: 

C:\Program Files\Digital Rapids\Stream\documents\SystemTags.html.
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Troubleshooting
Checking SD hardware
If you suspect that you have a problem with your Digital Rapids board, you can 
run the Test App that was installed with your Stream software. Open the Stream 
folder (by default it is in C:\Program Files\Digital Rapids\Stream). If you have a 
DRC-500 board run the DRIdahoTest.exe file. If you have a DRC-1000 to 2600 
run the DRColoradoTest.exe file. Run the automated test, and if you see any 
failures then please contact Digital Rapids Support.

Unable to select live source as an input type
Your DRC hardware has not been properly installed or drivers have not been 
properly installed. To check on the Digital Rapids drivers in Windows XP, right 
click on My Computer and choose Manage. Click Device Manager. Click the + 
symbol next to Digital Rapids Devices. Right click on the Digital Rapids device 
and choose Properties. The Device Status will be displayed on the Device 
Properties window.

Codec Profile > Create only shows Windows and Real as options 
Additional options such as Quicktime, Direct Show and any purchased options 
will only be enabled once the product has been registered. You can register 
your product on line from the Digital Rapids web site by selecting Tools > 
Register Online from the Stream menu.

When starting Stream software, a message appears saying that the 
hardware is disabled.
The product has not been registered within 30 days of the software installation 
and your grace period has expired. You can register your product on line from 
the Digital Rapids web site by selecting Tools > Register Online from the 
Stream menu.

Dropping frames when encoding video
Not all codecs perform well in a real time environment. Codec factors include 
file resolution (width x height), data rate, encoder complexity, and codec type. 
System factors include CPU, memory PCI bandwidth and hard drive speed.
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You should be able to encode a full sized (720x480 or 720x576) uncompressed 
AVI on most systems. Other efficient codecs include WM9 (Microsoft) and 
MPEG1 and MPEG2 (MainConcept). 

Less efficient codecs include QuickTime, Real Helix, MPEG4 and Flash 7 (with 
Sorenson ACE) or Flash 8 (with On2 VP6). With these less efficient codecs 
you should be able to encode to a 320x240 sized file in real time on most 
systems. 

Should you need to encode to a full sized clip on a system that cannot encode 
to the file format you want in real time, encode to an uncompressed AVI in real 
time, and then transcode to your final output format.

When encoding the CPU status at the bottom of the Stream window will climb 
up as you put more demands on the system. If the CPU usage reaches 100% 
then the buffer will start to fill. If the buffer reaches 100% then the encoded file 
will start to drop frames.

If you are using a system with multiple CPU cores, but the codec you have 
selected cannot use multiple cpu cores, then your CPU usage may look low 
when the buffer begins to fill. For example, the Flash 8 On2 codec can only use 
one CPU core, so on a quad-core system, a CPU usage of 25% (or slightly 
more) during encoding indicates that 100% of 1 of the 4 CPU cores is being 
used by the codec, and since none of the other CPU cores can be used by the 
codec simultaneously, you have reached your processing limit for that codec.

Can’t preview the audio
You will not be able to preview the audio until you have at least one codec 
profile in your list. If you have more than one audio channel enabled in your 
source profile, each codec profile in your list can be assigned an audio channel 
independent of the other codec profiles using the Audio drop-down box on the 
input tab.

Video preview is not updating
Occasionally you will change a setting and the video preview will not update 
correctly. If this happens toggle the Monitor Source button off then on again.

Video preview stops during encoding
Check to make sure you have selected Video Preview > Source. The Video 
Preview > Encoder option only works for some codecs.
 



Buffer usage is higher than normal during encoding
Check to make sure you have selected Video Preview > Source. The Video 
Preview > Encoder option requires some buffering so it will increase your 
Buffer usage.

Can’t encode: check codec profile
When you can’t encode you will normally see a red X next to the codec profile. 
Double click the profile to open an error window or hover your mouse over the 
codec profile to see the message as a tool tip. Common problems are no 
archive file name or other output modes selected, or trying to encode only 
video with a codec that is expecting video and audio.

Unable to use MPEG files as a DirectShow Media Files Input source
A DirectShow filter for MPEG has not been installed on the system. Note that 
if you have install the MainConcept option with your Digital Rapids Stream you 
will have an MPEG codec. If you have purchased a DRC-500 without the 
MPEG option you can download codecs that include a DirectShow filter for 
MPEG from http://www.free-codecs.com/Video_Codecs.htm.

Can’t connect to the deck or can’t start the deck capture
The Logger and Deck Control window have changed slightly from Stream 1.5. 

When you run the Logger as a stand-alone app you will see a Configuration 
button that will allow you to create a deck configuration file (with port, timecode 
type, etc. specified). When you run the Logger from the Deck Control window 
the Logger will use the deck configuration you set in the Deck Control window 
(Options > Configure).

You now start the capture using the Start button on the main interface.

Can’t create an AVI file that is over approximately 512GB in size
If you are using Windows XP SP2 or earlier, this is a known issue. Update to 
SP3 or refer to http://support.microsoft.com/kb/927544 for the Microsoft hotfix.

After this fix has been applied, you should be able to create files up to 1.7 TB 
in size. 

Can’t use a 3GP file as a source file in Stream
By default 3GP files use the QuickTime decoder. If your .3gp file cannot be 
decoded, try switching the input from “Auto” to “DirectShow”.
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Can’t control the hardware using Windows Remote Desktop
If you are logged on using Remote Desktop, you must be the first person 
logged in. To force this (logging out other users) run Mstsc in a Command 
window with the following -v and -console options (replacing the 
server.ip.address with your server ip address):

For XP Service Pack 3: Mstsc -v:server.ip.address -admin

For XP Service Pack 2 or older:  

Mstsc -v:server.ip.address -console

Vista Issues
Disable the Vista power saving mode. When Vista enters “power saving mode” 
(hibernation), the DRC Stream hardware is disabled, and when you return to 
the normal mode and attempt to use the DRC Stream hardware again, it 
cannot be re-enabled without rebooting the system.

Turn off the Vista UAC (user account control) before installing the Stream 
software (including drivers for the DRC Stream hardware).  Keep the UAC off 
when using the Stream software. 

After encoding an archive file, when you click on the Play button next to the 
Archive button to open the file, if the file would normally be played back in 
Windows Media Player the player will open, but the file will not be loaded.  This 
same player behavior can be seen outside of Stream in Windows Explorer by 
right-clicking on a media file and selecting “Open with” and selecting the 
Windows Media Player: namely the player will open, but the file will not be 
loaded.

The Stream Software User’s Guide cannot be opened from the main Stream 
Help menu.  It can be opened from the Vista Start Menu shortcut.
 



Encoding Performance
You will find that some codecs use more CPU and Buffer space than others. 

If you are doing a live encode, keep an eye on the status bar at the bottom of your 
window. Once your CPU and Buffer space has reached 100% you will start 
dropping frames.

NOTE: Results will vary depending on the specific footage being encoded.

Live Encoding with single Quad Core X3230 system

Notes: 
- Tests performed with Video Preview disabled in Stream.
- The Flash8 On2 VP6 codec can only use one of the 4 CPU cores in the system for encoding.

Codec Profile Bit Rate 
(CBR)

Steam Type Peak/Ave 
Buffer

Peak/Ave 
CPU

Dicas H.263 @ 176x144  
+ Dicas MPEG4 @ 240x180 
+ Dicas H.264 @ 320x240

140 kbps 
200 kbps 
300 kbps

RTP 0 / 0 25 / 16

Dicas H.264 @ 176x144  
+ Dicas H.264 @ 320x320  
+ Dicas H.264 @ 384x288 

150 kbps 
300 kbps 
200 kbps

RTP 0 / 0 39 / 27

WM9 VC-1 @ 720x480p 29.97fps 2 Mbps HTTP Push 11 / 5 31 / 16

MPEG2 TS @ 720x480p 29.97fps 5 Mbps RTSP/RTP TS 3 / 2 56 / 12

H264 TS @ 720x480i 29.97fps  
CABAC IBBP-Frame

2 Mbps RTSP/RTP TS 18 / 2 82 / 58

Flash8 On2 VP6 @ 640X480p 
29.97fps

1.5 Mbps RTMP Push 1 / 0 33 / 13
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Transcoding with single Quad Core X3230 system

Notes: 
- Tests performed with Video Preview disabled in Stream.
- Each instance of the Flash8 On2 VP6 codec can only use one of the 4 CPU cores in the system 
for encoding.

Codec Profile Bit Rate 
and Type

Encoding 
Frame Rate 
(fps)

Peak/Ave 
Buffer

Peak/Ave 
CPU

1 x WM9 VC1 @ 720X480 Progressive 2 Mbps CBR 48.3 0/0 50/35

2x VC1 @ 720x480p29 2Mbps CBR 45.9 0/0 80/58

1x MPEG2 @ 720x480p29 5Mbps CBR 50.1 0/0 85/35

2x MPEG2 @ 720x480p29  5Mbps CBR 41.6 0/0 99/61

1x H264 @ 720x480i29  
CABAC IBBP-Frame

2Mbps CBR 31.6 4/0 83/68

1x H264 @ 720x480p29  
CABAC IBBP-Frame

2Mbps CBR 39.2 4/0 86/70

1x H264 @ 720x480i29  
Baseline IP-Frame

2Mbps CBR 38.6 4/0 78/66

1x H264 @ 720x480p29  
Baseline IP-Frame

2Mbps CBR 38.0 4/0 80/67

1x On2 Flash8  @ 640X480p29 1.5Mbps 
CBR

51.6 0/0 46/32

2x On2 Flash8  @ 640X480p29 1.5Mbps 
CBR

48.3 1/0 78/65

1x On2 Flash8  @ 720X480p29 1.5Mbps 
VBR

52.1 1/0 42/31
 



Transcoding with dual dual-core CPUs: two of Intel Dual XEON 5160 3.0 GHz

Profiles  
(For SD, all encoded from a 720x480 30 fps source) 
(For HD, source in matched output)

Encoding 
Rate (fps)

Average 
CPU 
Usage

2 at 720x480, MPEG2 MP@ML, 30 fps, 6Mbsp, CBR 72.0 50%

2 at 720x480, WM9, 30 fps, 1.5 Mbps, CBR 77.1 79%

4 of WM9, 720x480, 480x360, 320x240, 240x180 65.1 85%

4 at 320x240: WM9, MPEG2, Helix 10, QuickTime 38.6 70%

4 at 720x480: WM9, MPEG2, Helix 10, QuickTime 24.5 55%

1 at 1280x720, of MPEG2, MP@HL, 60 fps, 18Mbps 69.7

1 at 1920x1080, of MPEG2, MP@HL, 30 fps, 18Mbps 30.2

1 at 1280x720, of WM9, 24 fps, 6Mbps 34.3

1 at 1920x1080, of WM9, 30 fps, 9Mbps 14.7

1 of Digital Rapids AVC (Nero Digital), 720x480, 30fps

1 of Flash 8 (On2), 720x480, 30fps

1 of Flash 8 (On2), 480x360, 30fps

1 of Ateme/Manzanita H.264 transport stream for STB
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Live Encoding with dual Xeon 3.6 GHz CPUs (single-core) system

Live Encoding with dual Xeon 3.6 GHz CPUs (single-core) system

Profiles  
(single codec used)

Average 
Buffer 
(Peak)

Average 
CPU 
(Peak)

WM9 (720x480, 1500k CBR) 14 (16) 31 (49)

QuickTime, Codec: None (RGB) (640x480)  
(Depth: millions of colors) 

12 (32) 17 (42)

Sorenson ACE MOV (720x480, 1250kbps VBR) 1 (16) 79 (95)

Sorenson ACE MPEG4 (536x402, 512kbps, VBR) 10 (63) 51 (59)

Sorenson ACE AVC H.264 (320x240, 800kbps, VBR) 0 (5) 51 (89)

Sorenson ACE SWF (560x420, 950kbps, VBR) 2 (24) 49 (67)

Sorenson ACE FLV (560x420, 1024kbps, VBR) 10 (50) 52 (60)

Helix 10 (720x480, 1500kbps VBR)  
(note: encoding complexity set to Low)

1 (3) 45 (69)

Helix 9 (720x480, 1500kbps VBR) 0 (2) 57 (91)

Profiles  
(multiple codecs used)

Average 
Buffer 
(Peak)

Average 
CPU 
(Peak)

WM9 (720x480, 1500kbps CBR) 
WM9 (480x360, 750kbps CBR) 
WM9 (320x240, 512kbps CBR)

13 (19) 76 (100)

MPEG2 for DVD (720x480, 6000kbps VBR) 
WM9 (720x480, 1500kbps CBR) 
(Note: MPEG2 encoder quality set to 40)

19 (75) 70 (82)

Helix 10 (480x360, 768kbps CBR) 
Helix 10 (320x240, 512kbps CBR) 
(Note: encoder processes complexity set to medium)

0 (12) 81 (100)

WM9 (320x240, 512kbps CBR) 
Helix 10 (320x240, 512kbps CBR) 
Sorenson MOV (320x240, 512kbps VBR)

2 (4) 82 (99)
 



The Stream SDK
If you are a developer, you may be interested in acquiring the Stream SDK. This is 
available only to qualified customers. To acquire the SDK please contact your 
regional Digital Rapids Technical Support or Sales. They will provide you with a 
Mutual Non-Disclosure Agreement form to fill in and return, and providing the 
terms are agreeable to both parties, the Stream SDK will be emailed to you.

The Stream SDK is available in 3 levels:

• The High-level SDK provides you with Web Service calls to control the 
Stream Server service and one or more instance of encoder.exe. 

• The Mid-level SDK provides the mid-level C APIs and the creation of user 
generated xml files used to run Stream projects

• The Low-level SDK is not normally given out, except in special cases. It is 
used to access raw video and audio data from the DRC hardware, and is 
based on the Microsoft COM architecture.

Support for the Stream SDK is limited, and is not provided by the regular Digital 
Rapids Technical Support staff. Instead an SDK support contact will be provided 
when you are sent the Stream SDK.

Using the Web Services API

The Web Services API provides you with one way to control the Stream Server 
service and one or more instance of the Digital Rapids encoder.exe.

1. When you installed Stream you also installed the DRC Stream Server as a 
service. There are two possible ways to prepare this service for remote control.

• Launch the Stream Server application. From the Windows Start menu, 
choose Start > Programs > Digital Rapids > Stream > Stream Server. Or 
you can launch StreamServer.exe from C:\Program Files\Digital 
Rapids\Stream. This will open the Digital Rapids Stream Server application 
and place a blue Digital Rapids icon in your system tray.

• Use the Windows Control Panel to access the local services (Control Panel 
> Administrative Tools > Services). Scroll down the list and look for the DRC 
Stream Server service. Double click on this service to open the Properties 
window. You can set the service to Automatic, and start the service if it is 
not currently started.
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Use only one of these two methods to prepare the Stream Server service for 
remote control, to avoid conflicts.

The Web Service can be enabled using the Stream Server application. From the 
application’s menu select Options > Preferences to access the settings. If you 
make changes you will need to close the Stream Server application, and then 
either restart the application or restart the service.

2. Launch at least one instance of the core encoding application, Stream Encoder 
Process. You can launch the Stream Encoder Process via the API using the 
launchEncoder command. Refer to the API documentation for more information 
about launching the Stream Encoder Process using the launchEncoder command. 

To launch the Stream Encoder Process manually use Start > Programs > Digital 
Rapids > Stream Encoder Process or open a command prompt window and launch 
“encoder.exe -remote”. (The encoder.exe app is found by default in C:\Program 
Files\Digital Rapids\Stream). If you have more than one DRC hardware device 
installed in your system, the Streaming Hardware Selection window will open and 
you will need to select the device you want to use.

Note that for a DRC-2000 or 2600 (a dual channel board) you will need to start two 
instances of the Stream Encoder Process to enable you to access both channels 
of the board.

You will see an additional blue Digital Rapids icon in your system tray for each 
instance of the Stream Encoder Process.

3. If you will be running a post-encode process that requires the Batch Processor 
(such as the FTP function), then you will also have to launch the 
DRBatchServer.exe. This will add a gray Digital Rapids icon to your system tray.
 



There are many available tools that can inspect and call methods on a Web 
Service.  These tools can be used to quickly experiment with the API.  One of 
these tools is SoapUI (www.soapui.org). The following instructions show you how 
to get started with SoapUI.

1. Launch SoapUI. Right click on “Projects” and choose “New WSDL Project”. Fill 
in a Project Name and click OK.

2. Right click on your newly added project, and select “Add WSDL from URL”. 
This will open a window that will allow you to enter the WSDL URL. By default, for 
Stream this is http://<ipaddress>:port/Stream?wsdl, where the ipaddress and port 
must be exactly what is entered in the Stream Server Preferences, for example, 
http://192.168.0.144:43778/Stream?wsdl. Note that if the Stream Server 
Preferences uses the numerical ip address, you cannot substitute localhost in the 
WSDL URL dialog in SoapUI.

When you click OK you will be asked if you want to “Create default request for all 
operations”. Select Yes. SoapUI will add the SOAP/http Binding for the Stream 
"StreamPortBinding" PortType to your project and create nodes for each 
operation.
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4. Expand an operation node an you will see Request 1. Double click on Request 
1 to open the Request Editor in the right hand pane of the SoapUI. 

If the default request created by soapUI needs values to be supplied in the 
request, a “?” will be shown in the request editor. Replace/remove any values as 
required and click the button with the green arrow icon to submit the request. (This 
green arrow button is the one found above the Request Editor.)

The request will run in the background and its response will be displayed in the 
Response panel, found to the right of the Request Editor panel.

For more information, and sample code, please obtain the Stream SDK.
 



Using GPI Triggers
GPI triggers are physical connections between two pieces of equipment.  
Typically GPI triggers are based on a change of state on a monitored pin of the 
serial port.  For instance you could create a GPI trigger which was operated by 
the alarm closure of an alarm system, or a port on a piece of broadcast 
equipment.

Because of the variety of configurations possible, each GPI cable should be 
custom manufactured by someone who understands both pieces of equipment 
to be connected.  If you are not comfortable reading electrical schematics, and 
building custom cables you should provide the included schematic to a 
qualified technical engineer. (See the end of this section for a GPI Schematic.)

GPI Configuration
Stream supports GPI inputs which can be configured in a variety of ways. Both 
COM ports are supported and the state of the trigger pins can be configured to 
match most situations. 

To configure your GPI input select the Trigger button from the lower right of the 
main interface. Click on the GPI tab. Create a new GPI profile by clicking on 
the New Profile button (at the end of the drop-down box). You will be asked to 
set your Com Port, GPI Switch (CTS or DSR) and the Trigger State (Closed or 
Open). You can then use the Save As button to save the GPI profile.

The GPI profile settings will be displayed under the drop-down box. Note that 
there are separate GPI settings for Starting and Stopping encoding. Set up 
both states. Choosing ‘Okay’ on the Trigger Settings window will arm the 
system for GPI triggering.

If you do not want to use GPI triggers return to the GPI tab and use the drop-
down box to choose Disabled from the GPI profile list.

Once you have created GPI profiles you will be able to choose an existing GPI 
profile using the drop-down profile list. After you have selected an existing GPI 
profile choose OK to arm the GPI trigger. 
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GPI Schematic
Note: GPI requires the installation of a 10k ohm resistor between DSR and 
DTR and between CTS and DTR.  This can be installed in-line in the cable 
where it is convenient.

Signal Name Signal Color RJ45 DB9 Miranda Little Red 
LTC Reader

SIN Green/White 6 2 N/C

SOut White/Green 3 3 N/C

DTR Orange/White 2 4 N/C

GRND Blue/White 4 5 White/Violet

DSR White/Brown 7 6 Violet

RTS White/Orange 1 7 N/C

CTS Brown/White 8 8 White/Orange

RIN White/Blue 5 9 N/C
 



Stream System Requirements

For System with Digital Rapids SD Hardware and Stream 3 Software
(For HD systems please see the DRC Hardware Guide)
CPU: minimum Pentium 4 Intel processor 
Recommended CPU: Dual Intel processors at 3 GHz or higher; dual quad-
cores recommended for systems for encoding AVC/H.264.

Note: The number of streams that you can encode in real time (and their 
resolution/bit rate) is dependant on the speed of your CPU. 

Memory: minimum 512MB PC-133 SDRAM; Recommended 1GB or more

PCI slot: Recommended: 64 bit 66MHz PCI slot or faster 
Digital Rapids boards will also work in 32 bit 33MHz PCI slots or PCI-X slots. 
If used in a PCI-X slot, the bus speed will fall back to 66MHz.

Hard Drive: 
For SD capture: 7200 RPM IDE hard drive (or faster / higher RPM drive)

Graphics Display card: VGA card supporting Direct Show with minimum: 
128MB RAM, Recommended: 256MB RAM or higher; Minimum: 1024 x 768 
resolution

Operating System: Recommended: Windows XP SP3 (or higher) or Windows 
Server 2003; Microsoft Vista is supported within the limitations listed in the 
Troubleshooting section. (Digital Rapids boards will also work on Microsoft 
Windows 2000 SP4, but Stream 3.0 is not officially supported on this OS.) 

DirectX:  
DirectX 8.1 or higher is required. DirectX 9 or higher recommended.

Note: Windows XP includes DirectX 8.1. 

(If you are using Windows 2000 with Digital Rapids hardware you MUST install 
DirectX 9 or higher BEFORE you install the Digital Rapids hardware. It is on 
the Digital Rapids CD or you can download it from Microsoft.)

QuickTime: If you would like to make QuickTime files using Stream 2.3 or 
higher you must install QuickTime 7. Note that Stream 2.3 or higher is not 
compatible with QuickTime 6.

Please see www.digital-rapids.com for the latest system information.
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Contact Information
North and South America

Digital Rapids Corporation 
90 Allstate Parkway, Suite 700 
Markham, Ontario L3R 6H3 
Canada 

905-946-9666 voice 
416-352-0716 fax

Sales: sales.na@digital-rapids.com; 905-946-9666 x 212 (North America) 
    sales.la@digital-rapids.com; +54-11-4700-0051 (Latin America)

Technical Support: support.na@digital-rapids.com; 905-944-3513 (direct dial) 
or using the main line: 905-946-9666 x 113

General and OEM: info@digital-rapids.com

Europe, Africa, Middle East
Digital Rapids Corporation Ltd.  
Passfield Business Centre 
Lynchborough Road 
Passfield, Hampshire 
GU30 7SB  
UK

+44-1428-751012 voice  
+44-1428-751013 fax 

Sales: sales.eu@digital-rapids.com; +44-1428-751012 

Technical Support: support.eu@digital-rapids.com; +44-1428-751012

Asia Pacific
Digital Rapids Asia Ltd. (China) 
45/F, The Lee Gardens 
33 Hysan Avenue, Causeway Bay 
Hong Kong 
China

+852-3180-2382 voice 
+852-3180-2383 fax

Sales: sales.cn@digital-rapids.com; +852-3180-2382 (China) 
sales.ap@digital-rapids.com; +61-2-9546-1300 (Australia) 
sales.in@digital-rapids.com; +91 124 4354107 (India)

Technical Support:  
support.cn@digital-rapids.com; +852-3180-2382 (China)
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